The ImagePrint 10.X for Windows
Troubleshooting Guide
Revision 1.0

Despite our best efforts, when computers, software, printers and color management come
together, somewhere along the line problems may occur. This guide will help to solve the
majority of issues that users run into as well as answer common questions regarding the
use of ImagePrint.

Note: This guide is designed for users of ImagePrint 10.x and may not apply to earlier
versions of the software. Users of most previous versions can access trouble-shooting in
the back of their manual, which is typically installed into their ImagePrint folder.

The latest revision of this guide is always available on the Technical Support page on the
ColorByte web site: www.colorbytesoftware.com
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Contacting Technical Support
Most issues with ImagePrint can be solved by consulting this Troubleshooting guide, however, there are times you
need a helping hand to get past some problems. For that, there’s ColorByte’s technical support department.
ImagePrint comes with phone and email support for the initial installation of the software. Once you are up and
printing, support normally shifts to email only for the life of the current version. But don’t be discouraged--ColorByte’s email support is among the best in the business, and responses are typically quick and accurate. (In fact,
email response times are usually much quicker than those for phone calls).
That said, support is always more efficient if, when contacting us, you include useful information on the problem you
are experiencing. Please consult the following guidelines when corresponding with our support dept. to receive a
solution to your problem more quickly. ColorByte’s email support address is: support@colorbytesoftware.com

Please remember: If you are not on the current version of ImagePrint or under a maintenance contract you may no longer be eligible for support.

Introducing...“Gather ImagePrint Diagnostic Information”
If using Profile Manager version 2.2 or above, a new feature can be found under the File menu within that utility: Gather ImagePrint Diagnostic Information. Choosing this option will cause the Profile
Manager to gather information about your ImagePrint installation including recent job files, log files,
configuration files, and computer settings. You can then use this feature to upload or email a copy of
these diagnostics to ColorByte. (The Profile Manager utility is included in your ImagePrint folder when
ImagePrint is installed.) This is the easiest and most thorough method of providing ColorByte’s
Support Dept. with information on your system.

Things to include in all correspondence with ColorByte Support:
• Your name
• Your 6 digit dongle number
• The printer you are using and how the computer is connected to it.
• The version and build number of ImagePrint (this can be found by choosing “About” under the ImagePrint
HELP menu)
• The platform (Mac or PC) and the OS (i.e., OSX 10.5.2, or Windows 7).
• A brief (but detailed) description of the problem you are having.  Make sure to include any error messages
exactly as they appear. Some questions you may also wish to include answers for are:
-

Is this a brand new installation of ImagePrint on this computer?

-

Has anything changed on your system prior to the problem?

-

How are you connected to the printer?

-

Have you reproduced the problem, or did it just happen once?

-

Does the problem only happen with certain images? (if possible, try printing the “sample portrait.tif” image
that is located in the Test Images folder off the ImagePrint folder as a test.)

-

What have you already done to try to correct the problem?
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Other Information that may be helpful to include in the email:
(Note: If using the Profile Manager’s Gather Diagnostics option (recommended) mentioned earlier
in this section, these items (and much more) will be included automatically)
• Job File: - This is typically the most valuable diagnostic information we can receive. If you are having a
problem related to printing, a “job file” is often the first thing we will request.  Job files are the files sent to
spoolface when you click PRINT and contain all the information about that print job.  (continued)
To get a job file:
- In Spoolface, move the print job to the finished side of the spoolface window.
- Double-click the job--a text window will appear
- Highlight all of the text in the window (scroll down to get it all)
- Copy and paste this information into your email.
• IP Config  - The file called “ip config” is located in your ImagePrint USER DATA folder. (\ProgramData\
ColorByte Software\ImagePrint).  You can also get there by going to the ImagePrint program folder (/ program
files(x86) / ImagePrint) and double-clicking the ImagePrint USER DATA Folder shortcut.  This file contains
information on your installed printers.  Attaching that file to an email can be helpful in diagnosing problems
with ImagePrint itself (such as launch problems, or problems with communication with the printer)
• LOG - The spooler log file is found in the SPOOL folder.  (c:\ProgramData\Colorbyte Software\Imageprint\
spool\log).  Attaching this text file can be helpful in diagnosing persistent error conditions when printing.

Things not to include in a support email
• Vague or very general information, such as “I get an error”, without specifying what it is.  These types of
emails waste time as they invariably require another round of emails as we ask for specifics.
• Images or screen grabs over 1 megabytes in size.  Often, big files sent over email don’t come through properly.  Screen grabs of settings can be useful, but please make sure to keep them to a small size
• Pricing and sales questions.  Our support department is not able to answer specific questions on pricing.  
Those are best sent to our sales dept. at: sales@colorbytesoftware.com

Support Availability
Colorbyte Technical Support is available during regular business hours: 9:00 am to 5:00 pm, Eastern Standard
Time. Most emails are responded to within 2 hours of receipt (often much more quickly) however volume received
and other factors may affect response times. If you have not received a response within 24 hours, please resend
the email. If you are no longer using the current version of ImagePrint, you may no longer be eligible for support.
If you are not on the current version of ImagePrint or under a maintenance contract you may
receive an automatic response from support detailing your support options.
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Where can I go to learn more about ImagePrint?
Users Guide: The ImagePrint user’s manual is the first place to find information about the various tools and
features available within the software. The manual is installed in your ImagePrint folder. The default location
is:
c:\Program Files(x86)\Imageprint\ImagePrint Manual.pdf
You can access the manual by choosing ImagePrint Users Manual from the Help menu within ImagePrint. The
latest revision of the manual is also availabe on our web site’s (www.colorbytesoftware.com) Support page.
The manual is large and comprehensive, and is often best used as a general reference rather than read cover-to-cover.

Training Movies: RECOMMENDED Sometimes you need to see a feature in action in order to understand it.
The numerous training movies located on our web site: www.colorbytesoftware.com can be incredibly useful
in that regard.

Users Group: The Yahoo ImagePrint Users Group is a great source of information about ImagePrint. Users
of the software share their advice, tips, solutions (and complaints) in an often lively discussion. Many of the
participants are long time users of ImagePrint and gurus in the ways of printing. To access the group use the
following link:
http://tech.groups.yahoo.com/group/colorbyte_imageprint/

Workshops, trade shows, seminars: While ColorByte doesn’t currently produce workshops or seminars,
there are existing ones that utilize and teach with ImagePrint.  Also, ColorByte personel sometimes appear at
industry trade shows or participate in dealer seminars. For information on upcoming events in your area, contact the sales department at:
sales@colorbytesoftware.com

Updates: The latest build of ImagePrint can be found at the ColorByte support page:
http://www.colorbytesoftware.com/Ver10/support.shtml

For more information on updating, see Updating ImagePrint
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Which Windows versions are my copy of ImagePrint compatible with?
ImagePrint 10.0 is compatible with Vista (32 and 64), Windows 7 (32 and 64) and Windows 8 and
Windows 10.
If your copy of ImagePrint is incompatible with your Operating System, you will need to update the
software in order to use it on that OS. Depending on your current ImagePrint version, updates may
be free or may need to be purchased. To find out your current upgrade eligibility and applicable pricing, send an email request including your dongle number to: sales@colorbytesoftware.com
The latest build of ImagePrint can be found at the ColorByte web site’s Downloads page:
www.colorbytesoftware.com
For more information on updating, see Updating ImagePrint
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This section is devoted to issues related to installing, uninstalling, or launching ImagePrint.

Re-installing your ImagePrint printer driver - A basic walkthrough
Sometimes reinstalling your printer driver is the quickest solution to a stubborn problem. The IP Setup utility, located
in your ImagePrint folder, can be used to remove and reinstall your ImagePrint printer(s). Follow the below instructions to remove and reinstall your ImagePrint printer driver.
• Make very sure that ImagePrint, and Spoolface, are NOT running (Important!)
• Launch IP Setup by double-clicking it from your desktop icon, or from your ImagePrint folder.
( C: \ Program Files (x86) \ ImagePrint \ IPSetup.exe )
• Choose any installed printers within the window by clicking them, then click the DELETE PRINTER button to
remove it. (IMPORTANT--This will delete all your old print jobs on the finished side of Spoolface. If you
wish to keep those old jobs you may skip this step and ADD the printer “over” the previous one without
deleting it first, although that method may reduce the chances of this procedure correcting your problem)
• Choose the ADD PRINTER button. Then select your printer type from the drop-down menu in the window that
appears and click Next.
• Specify if this is a HOST installation (the dongle is attached to your computer) or a CLIENT (you will be sending jobs to another computer). In most cases, HOST is the correct choice unless you have already installed
ImagePrint on another computer and have the dongle attached to that one. Click Next.
• Specify how the printer is connected to the computer:
1. If you are connected via USB or Firewire to the printer:
Choose “Local Port”, then click the “PORTS” button
In the PORTS SELECTION window that appears, click on the manufacturer’s driver (for instance,
EPSON STYLUS Pro 4800) on the left.
Click OK.
2. If connected via ETHERNET (network) to the printer:
Click the NETWORK button, and enter the IP Address of the PRINTER in the field provided. (If you do
not know the printer’s IP Address, consult the Networked Printer Settings section later in this guide).
• Click NEXT.
•   Click Finish if you have previously licensed the printer (the license will have been saved and will be applied when
you click Finish--no need to enter it again). If you have NOT previously licensed the printer, enter your 19-21 digit
encryption into the encryption field and click Finish.
Your installed printer should now be listed in the IP Setup window, with LICENSED shown beside it.

Consult the appropriate section of this guide if a problem or error occurs with any of the above procedures.
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If the Installer fails or never launches, check the following for possible causes and solutions:
Anti-Virus software: Failure to install may be caused by Virus detection software preventing the second
phase of the ImagePrint install from proceeding.
Permissions: You may also see this error if there is a permissions issue that prevent the installer from
writing to the necessary folder (c:\program files(x86)). Try right-clicking the installer and choosing to “Run
As Administrator”.
Disk space: It is also possible that there is insufficient disk space to complete the installation (ImagePrint
requires approx. 100 megabytes of disk space, depending on the number of profiles you have selected to
install).
Problem with CD-ROM: If you are installing from cd, you may have a problem with the cd, or your cd
drive may have compatibility issues preventing it from reading the cd.  (If you see any “media” errors this
is most likely the case). See the section later in this guide: Problems with the CD-ROM for information
on this issue.
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Problems with the CD-ROM
If installing ImagePrint via CD-ROM, some errors may be due to problems with the physical CD-ROM disk.  
Any “media” errors generated by the system are a possible sign that this is the problem.  Below are some
suggestions that may help get around disk problems:
• IMPORTANT: Check your c:\program files(x86) folder to see if an ImagePrint folder has been created.  
If so, delete it before retrying the installation. Installing over a partially installed folder may cause problems later on.
• Check the CD for cracks or other obvious defects.  Clean the disk if you see any smudges or fingerprints.
• Try copying the files from the CD to a folder on the desktop of your computer.  If you can do this without
an error, then run the “ImagePrint Installer.exe” file  from the desktop folder.
• Try copying the files from the CD to a folder on a different computer. If this works, it indicates a compatibility issue with the CD drive on the first computer. Copy the installation files from the 2nd computer to
the first and then try to install it (or burn the files to a CD and use that as your installation disk).
• Finally, remember you can download the full installer from our update site on the internet.  Since we
update the software occasionally it’s likely your CD will become obsolete in time anyway so this is often
preferred over cd installation even if your cd is fine. Installing from the downloadable installer is the
best way to stay up to date. Check the section of this guide entitled: How do I Update ImagePrint for
more information on downloading the installer.
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Can’t uninstall ImagePrint
ImagePrint v10 now uses the standard Windows Uninstall procedures.
To uninstall ImagePrint, go to your Windows Control Panel and choose “Programs and Features”.  You’ll see
Imageprint v10 in the list of programs to uninstall.
After double-clicking the ImagePrint v10 entry, you’ll be prompted to Repair or Uninstall.  Choose Uninstall to remove
the software. You’ll be given a choice to remove User settings and spooler files as part of the uninstall process--if you
choose to remove those files, old jobs and settings will not be preserved if you reinstall ImagePrint later.
If the Uninstaller has any problems, it will likely be because a running process is preventing it from removing the
ImagePrint folder. Make sure that ImagePrint and Spoolface are NOT running when you run the uninstaller. If they
aren’t, and you still have an error in uninstalling, usually our background process “MUXD.EXE” is the problem. You
can manually end that process (and any “hung” uninstaller processes) and run the uninstaller again according to the
instructions below:
To end the “MUXD.EXE” process, the Windows Task Manager is used.  Launch the Task Manager by pressing the
Control->ALT->Delete keys on your keyboard, and choose TASK MANAGER in the window that appears.  In the Task
Manager, choose PROCESSES, and look for MUXD.EXE among the active processes.  Highlight the MUXD.EXE listing, then click the “End Process” button to end it (you may then get a warning message that you can click OK to).  If
you see any instances of the Uninstaller, you should end those in the same way.
If you still have problems with the Uninstaller, you can manually uninstall ImagePrint using the procedure in the next
section, Manually Uninstalling ImagePrint.

Back

Manually Uninstalling ImagePrint
If the Imageprint Uninstall fails, you can manually remove ImagePrint by following these steps.
Step 1: Make sure no ImagePrint related programs are running. Make sure ImagePrint and Spoolface are closed, and
then kill the MUXD.EXE background process via the Windows Task Manager according to the following procedure:
Killing MUXD
To end the “MUXD.EXE” process launch the Task Manager by pressing the Control->ALT->Delete keys on your keyboard,
and choose TASK MANAGER in the window that appears.  In the Task Manager, choose PROCESSES, and look for
MUXD.EXE among the active processes.  Highlight the MUXD.EXE listing, then click the “End Process” button to end it
(you may then get a warning message that you can click OK to).  Then close the Task Manager
STEP 2: Go to / Program Files(x86) /ImagePrint, and double-click the “ImagePrint USER DATA folder” shortcut.
Move up one directory level (you will be in a folder called “ColorByte Software” and there, delete fhe folder called
ImagePrint. This will remove all your settings and old print jobs.
STEP 3: Go to the folder: / Windows / SysWow64  and delete the file “libiccdll.dll” if it is there.  NOTE: You may
need to adjust your window settings to Show Hidden System Files if you do not see any “dll” files in this folder.
STEP 4: Delete the ImagePrint folder from its location in the “Program Files(x86)” folder of your system (default: c:\
program files(x86)\imageprint)
STEP 5 (OPTIONAL): You can now delete any shortcuts on your desktop and the Windows Start Menu related to the
software.
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During installation I see a message that the driver has not passed Windows Logo testing to verify
its compatibility with Windows
This message indicates that the Dongle driver software installed during ImagePrint setup has not been submitted
for testing to Microsoft. This message can safely be ignored—click continue to proceed with the installation.

Back

Vista, Windows 7, 8 and 10 installation issues
ImagePrint should work fine on these operating systems, but due to the often more stringent security settings, you may need to adjust user access settings. If you have problems installing, try running the installer
as an Administratively privileged user. (You can do this by RIGHT clicking the installer and choosing Run as
Administrator.)
Issues with the dongle drivers not installing may also be due to security settings.   64 bit systems may not allow
the installation of unsigned drivers. If the dongle drivers report an error, or the dongle number does not show up in
the dongle field of the IP Setup window, consult the Vista 64 dongle issues entry in the Encryption, Demo and
Dongle Issues section of this guide.

Back

After Installation, no icons appear on my desktop
Shortcuts for ImagePrint, Spoolface and the ImagePrint PDF manual should exist on your desktop after installation.
If they don’t, it’s likely that you are not set to view the common Window’s desktop “All Users”.  You can locate the
missing shortcuts by opening the following folder, and dragging them out to your current desktop.
/Users/All Users/Desktop
You can of course also create shortcuts by going to the ImagePrint folder, right clicking the program you wish to
make a shortcut for (such as ImagePrint.exe or Spoolface.exe) and choosing “Create Shortcut” from the menu that
appears. Then drag the newly created shortcut file to your desktop.
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How do I update/upgrade my software?
- Updating to the latest revision of v10 when already running v10
Updating ImagePrint v10 to the most current revision is easy. The latest update of ImagePrint v10 is always available
from within the software via the Help -> Check for Updates command in the Main menu.
If, for some reason, the UPDATE process does not work (or you are not connected to the internet on your ImagePrint
computer) you can manually download the UPDATER and apply it.  To manually download the updater--go to the following internet location via a web browser:
www.colorbytesoftware.com/aupdates/v10
The latest update file will be available within the Mac or Windows folder on that site--download the update file to your
ImagePrint computer and double-click it to run.
- Upgrading from a previous version of ImagePrint to ImagePrint 10
Upgrading from a previous version of ImagePrint (such as 7, 8 or 9) to ImagePrint 10 is done via the ImagePrint
Upgrade utility, which can be downloaded from the SUPPORT page at www.colorbytesoftware.com
The Upgrade utility should only be used to upgrade a system already running a previous version of Imageprint. If
installing on a computer that does not have Imageprint installed, you should use the Full Installer, also available on
the ColorByte Support page.
!! Do not install or upgrade your software to a new VERSION (eg, from 7 to 8) if you do not already have an
ImagePrint encryption for the new version or the software will run in demo mode (putting the word DEMO on
your prints).
- Determining your Version and build (revision) number
To check the version and revision number of your copy of ImagePrint:
Macintosh - Choose “About ImagePrint” from the ImagePrint menu
Windows - Choose “About...” from the ImagePrint Help menu
- Installer and Upgrade Dtility Download Location
If you need to reinstall completely, the latest full install of Imageprint is available at the ImagePrint version 10.0
web site via the Technical Support page (accessed via the HELP menu):
www.colorbytesoftware.com
- Upgrade Eligibility and Pricing
Updates to a new revision of the same version (for example, from ImagePrint 10.0.1 to 10.0.2 is free.
Updating to a different version (for example, from version 9 to 10) usually is a purchased update, dependent on
how long since you’ve last updated or purchased. To check your status, send an email (including your dongle
number!) to: support@colorbytesoftware.com
Upgrade pricing depends on your printer license(s) and how long you have had the software since last updating. For
pricing information, email our sales dept. with your dongle number at: sales@colorbytesoftware.com
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Networked Printer Settings
The following information is taken from the Appendix of the ImagePrint manual

Getting the Printer IP Address
When printing to a printer via an ethernet connection, the TCP/IP communication protocol will be used.  This protocol
depends on each device on the network having a valid, unique IP Address.
You will need to provide the IP Address of the printer to IP Setup during installation so ImagePrint can communicate with it at print time.  Although different printers and network cards may vary, some method of accessing the ip
address, either by printing a status page or via the front panel of the device, will be available.
Front Panel: Most printers allow you to see and specify the IP Address via the front panel controls on the printer.  
Consult your printer’s manual for instructions for how to do this.
Status Page: In cases where you are not able to use the front panel to set the IP Address, check for a small or
recessed button beside the port where the network cable plugs into the printer. Pushing this button for one second
will cause most printers to output a page showing their current settings, including the IP Address. (Make sure to load
scrap paper on the printer--not expensive art paper!)
The IP Address will consist of 4 numbers, each between 0 and 255, separated by periods.  This is the number you will
need to use in the Network fields when installing the printer with IP Setup.

Checking TCP/IP connectivity
Once you have the printer’s IP Address, type it into the address field of a web browser (like Internet Explorer, Safari
or Firefox). Just type the 4 numbers of the ip address, separated by periods, into the address field--no other text (like
http://) is needed.  You should see the Printer’s HTML setup screen.Using a web browser in this way is a good test
of your computer’s TCP/IP connectivity to the printer--if the browser fails to show the printer’s setup screen, then you
know you have a TCP/IP communications problem.  
Even if you can print to the printer via the manufacturer’s driver, it does not necessarily mean you have TCP/IP communication to the printer. TCP/IP is required by ImagePrint when printing to a printer connected via Ethernet.
Different IP Address sub-nets between printer and computer: Communication problems can arise if the IP
Address numbering scheme of the printer is different than that of computer.  For example, if the printer’s IP Address
is: 192.168.0.12, and your computer’s is 30.40.16.8, then it is likely there will be no communication via TCP/IP
between the devices.  Compare the IP Address of your computer to that of your printer.  If the first 3 sets of numbers are not the same, this may be the problem (the last number should always be unique for each device). In
cases where the network schemes differ, you may not be able to communicate with the printer until the IP Address is
changed to one that is compatible with the rest of your network.
You can check the ip address of your computer on Macs via the Network Control Panel in System Preferences, on PC’s it
is available in the TCP/IP properties of your network card.
Continued
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Network Printer Settings (Continued)

Changing the printer’s IP Address (if needed)
Front panel: If the printer allows you to change the IP Address via the front panel on the printer, changing
the address is relatively easy--consult your printer’s manual for instructions.
Manufacturer’s utility: In cases where you can’t set the IP Address via the front panel,  you may need to
use a setup utility provided by the manufacturer. For Epson printers, the Net Assist utility is used to setup
the network parameters on your printer. That utility is provide on the Epson printer setup cd’s, and is also
available for download from the Epson web page.
Reset the printer to factory defaults: If your network uses a router, another method of changing the
printer’s IP Address is to reset the printer to its factory default settings by holding down the recessed button
on the network card of the printer while turning the printer off, then on.  When the printer comes back up,
it will default to DHCP mode, which will cause it to get a new IP Address from the router which should then
be correct for your network. Press the recessed button again (for 1 second) to output a new status page
showing the current IP Address and try to reach the again with the new IP Address in a web browser.
Setting the printer to a Manual (Static) IP Address
Once you have the printer’s IP Address (and have used it to specify the connection to the printer in IP
Setup), it is important that this IP Address doesn’t change in the future.  Otherwise, ImagePrint will no longer be able to find the printer.  An IP Address that doesn’t change is called “Static” or “Manual”.
To set your printer to a Manual IP Address, log into the printer via a web browser as described earlier in
this section by putting the IP Address of the printer into the browser’s address field and pressing the return
key. If the printer is reachable on your network, you should get a login window, with access to the printer’s
configuration settings.
Once you are on the printer’s setup page, you need to specify the “Method for Acquiring the IP
Address”. For most printers this setting is in the TCP/IP portion of the Configuration section of the
Printer Setup window, however the specific location and terminlogy may vary for some printers. The
choices are typically:   AUTO or MANUAL  Make sure it is set to MANUAL to prevent the IP Address from
changing each time the printer is restarted.  After changing the setting (if necessary) apply the settings-usually that is done via the SUBMIT button at the bottom of the setup screen.
Note: Most printer setup screens will ask for a user name and/or password when applying new settings.  
Unless you have previously set a password for your printer, the entries should be left blank for most printers
as that is the default username and password.  If that fails, try using the name “admin” for the username and
nothing for the password.
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ImagePrint licensing problems and solutions are listed in this section

How do I get my encryption number?
In order to enable your software to print in non-demo mode, you must first license it.
Licensing is done via an encryption number (19 to 20 digits in length) which is specially made for your unique dongle
number and the printer(s) you are using with ImagePrint. This number must be entered into the encryption field of IP
Setup after installing the printer.  When the License button is pressed, the installed printer will show “Licensed” and
you’ll be ready to print.
To get your encryption number, you must use the ColorByte license server web page. This server is available on the
internet 24 hours a day, 7 days a week.  
To use the ColorByte encryption server you will need 3 things:
1. Your unique 6 digit dongle number.
		 This number is provided on the dongle itself, as well as on the label on the back of your software cd case. It will
also be listed in any upgrade emails you receive from ColorByte.
2. The 6 letter login code for each printer type you will be using with ImagePrint.
		 This login code can be found on the back of your original cd case although be careful. That code will be for the
version of ImagePrint you’re original cd was created for. If you have updated to a new version, use the login
code you recieved in the emailed upgrade instructions from Colorbyte.
Remember--login codes are specific to the version of ImagePrint you are using--do not use an older login code to
get an encrytpion for a later version of ImagePrint or you will just re-receive the previous versions encryption code
and it will either fail to license the software, or cause it to print in demo mode.
If you have purchased multiple printer licenses for the same category of printer (for example, two 17 inch printers
such as an Epson 3800 and an Epson 4800) then you will have one single login code that is good for two printers.
3. A valid email address
Log on to the ColorByte encryption server by clicking the following web address or by pasting it into your web browser’s
address bar and pressing the return key:
www.colorbytesoftware.com/getcode.php
Note: Do not type the above address into a search engine such as Google. Put it in the address bar of the browser.
You will be taken to a page containing fields for the 6 digit dongle number, the 6 letter login code, and the email address
the encryption should be sent to.  After filling out those fields, click Submit to have the encryption emailed to you.  You
will usually receive the email within 5 minutes.
If you don’t receive the email: Check for any junk mail filters on your computer or in use by your Internet Service
provider---in most cases, instances where the encryption email is not received are due to them being misinterpreted as
junk (spam) mail by such systems.
There is no limit to the number of times you can use the encryption server, and you can use it with a different email
address if you have problems with your original email one.  Just make sure to use the right login code for  your version of
ImagePrint (i.e., don’t use your version 7.0 login code if installing version 10.0).
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Dongle number is never seen in IP Setup (it shows “0” in the Dongle Number field)
If the 6 digit dongle number does not appear in the Dongle Number field in IP Setup, try plugging the
dongle into a different USB port, or a USB hub if available. (Note that the light on the dongle does not
stay on all the time--not seeing the light is not necessarily an indication that the dongle is malfunctioning). Make sure to quit and restart IP Setup after trying a different port so it will recheck for the dongle.
If the dongle number still fails to appear, there may be a problem with the dongle driver.  When installing
ImagePrint, it is important to install the software BEFORE inserting the dongle, or Windows will attempt
to put its own driver in place when it senses the dongle.  Since Windows doesn’t have access to the
correct dongle drivers, the operation will fail, and the dongle will not be seen correctly by the system.
You can check if the dongle drivers have been installed correctly by opening the Windows Device
Manager. (To open the Device Manager, choose Control Panels from the Windows Start menu, then
System, then click Hardware, then the Device Manager link). If there is a question mark, or exclamation
mark, beside the USB entry for the dongle, the dongle drivers have probably been incorrectly installed.
To reinstall the dongle drivers:
• Right click the driver showing a question mark or exclamation point and choose “Uninstall” in the window that appears.
• Remove the dongle.
• Reboot.
• Once the computer is back up, open  the c:\program files(x86)\ImagePrint folder on your system, then the License folder, then the Marx folder.  Run the CBSetup program by double-clicking it.
When prompted, specify that it install the USB drivers for the dongle.
• Reboot again.
• Insert the dongle one more time.  The new hardware wizard should appear, and should automatically
find the drivers. (If you see a warning that they are unsigned by Microsoft, click OK to ignore it).  Let
the Wizard finish.
• Run IP Setup by double-clicking it from your desktop icon, or from the ImagePrint folder, and, hopefully, the dongle number will appear.
If the dongle still fails to appear in IP Setup, there may be a problem with the dongle, or with the USB
bus on your computer. If possible, try installing ImagePrint as a test on another computer to confirm the
dongle can still not be seen (for test purposes, no printer need be attached to the other computer--just
specify any printer within during installation).
If the dongle fails to appear on a second computer, the dongle may have malfunctioned (this is rare, but
can happen due to physical or electronic damage). Contact ColorByte or your ImagePrint dealer in this
case.

Until the dongle number can be seen by the computer, and your encryption can be successfully entered, the software will either run in DEMO mode (printing DEMO on all output) or will not print at all!
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The IP Setup program is used to both setup and license your printers. If, after entering your encryption the
installed printer(s) don’t show as LICENSED in IP Setup, check the following:
1. Make sure the 6 digit dongle number is showing within the dongle number field of the IP
SETUP window. If the dongle field shows “0”, then the system is not currently seeing the dongle.  
Check the entry in this guide entitled: Dongle never seen in IP Setup; Dongle number shows 0
2. If the dongle number is showing up correctly in IP Setup, but the encryption still won’t license,
check each of the following points:

• If you have more than one printer, make sure to try all of the encryptions you have received. IP Setup
will automatically apply the correct encryption to the installed printer it was created for. If that printer
type has not been installed yet, the encryption will be stored and automatically applied when the printer
is installed.

•   If you have multiple printers of the same category (for instance, two 44 inch (large format) printers) then
you will have received a single “multiple printer” encryption.  Enter this encryption in the License window
as you install each printer of that type.

• If you receive NO error message but the printer doesn’t show LICENSED at the end of the printer line
in IP Setup after entering the encryption, try deleting the file “ip auth”, from its location in the ImagePrint
USER DATA folder on your system.  You can get to the USER DATA folder by double-clicking the
“ImagePrint USER DATA folder” shortcut located in your “/program files(x86)/imageprint” folder.  Once
you have deleted the ip auth file, try to LICENSE the encryption again via IP Setup.

• Make sure you are using the right encryption for your version of ImagePrint. Even if IP Setup
shows LICENSED for the printer, an older encryption will cause DEMO to appear on your prints at print
time.  For instance, a 7.0 version encryption will NOT work with version 8.0, even if it allows you to
license the encryption in IP Setup.
		 If updating from a previous version, typically, the new encryption information is included when you
receive your upgrade information via email. (Do not use your old login code to receive your encryption from ColorByte’s encryption web server, as it will just send you the old version encryption
again).
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DEMO appears on all prints or NOTHING prints with red error messages appearing in spoolface
This occurs when ImagePrint is running in “DEMO” mode due to the dongle not being available or the proper
printer encryption not being in place.  (NOTHING will print if you are currently set to “Not Print in Demo”  
mode under spoolface’s QUEUE menu). Check SPOOLFACE’s status area, on the right side, for licensing
messages (typically in RED) to confirm this condition). If no red messages appear, and licensing appears
to be correctly set up, and nothing prints, then this may be a non-license related printing issue. See the
PRINTING ISSUES section of this document to troubleshoot.
Be aware that if you are using the Desktop (LITE) version of ImagePrint, use of TEMPLATES, PAGE
TILING, BACKGROUNDS, FRAMES, GALLERY WRAP and the COLOR CORRECTION TOOLS
will cause the software to run in DEMO Mode. Many Epson 2200, 2400 and 2880 printers are purchased as LITE versions.
If the above doesn’t apply, please check the following:
1.

Make sure that an ImagePrint dongle is attached to your computer. You may want to try
plugging the dongle into another USB port, or a USB hub. You can check to see if the dongle is
being seen by launching the IP Setup program from the ImagePrint folder, and checking that the
6 digit dongle number appears in the Dongle Number field.

2.

Make sure that a valid encryption has been entered and licensed in the IP SETUP utility. (IP
SETUP can be launched from the ImagePrint folder on your system (c:\program files(x86)\imageprint\ip setup.exe))
If even after entering the encryption, the installed printer(s) doesn’t show as LICENSED, see the
entry in this guide entitled: Encryption won’t license in IP Setup.

3.

If the dongle is connected to your computer or USB hub, the printer has been licensed in IP
Setup, and DEMO still appears on prints, double-check in IP Setup that the dongle is still seen.
(Sometimes, plugging other USB devices in or unplugging them can cause the dongle to not be
seen temporarily).

4.

If none of the above suggestions apply, its possible that the dongle drivers have been incorrectly installed. Try the procedure listed in the previous entry Dongle number never seen In IP
SETUP.
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Vista 64 and Windows 7 and 8 dongle issues
If an error occurs when you plug in your dongle on a Vista 64 system, or the dongle number does not show up
in IP Setup on a Vista 64 system, there may be problems with the dongle drivers and that operating system.
An alternate set of dongle drivers is available in the ImagePrint folder after installation that may work better with
Vista 64.  Try the following procedure to use these drivers instead of the standard ones:
• With the dongle plugged into a USB port, open the Windows Device Manager
(Choose Control Panels from the Windows Start menu, then System, then click the Device Manager link).  
• In the “Universal Serial Bus”  (USB) interface list, look for the dongle driver.  It may appear with the name
“CBUSB” in the title, or appear as a device with a question mark or exclamation mark beside it.  If unsure
which device represents the dongle, try removing the dongle from the USB port.  Watch as the Device
Manager list updates to reflect the absence of the dongle. Plug the dongle back in, and note which device reappears in the list. That’s the dongle driver.
• Right click the dongle driver in the Device Manager list, and in the menu that appears, choose “Update Driver
Software”.
• In the window that appears, choose to Browse your computer for the driver software, and navigate to the following folder:
                C:\Program Files\ImagePrint(x86)\license\Marx\vista_cb_drivers
• Click “Next” to have Vista update the dongle drivers to the new versions.  Once it is done, close the device
manager, and try launching IP Setup (from the ImagePrint folder) to see if the dongle number now appears.
(If the vista_cb_drivers folder is not available, contact ColorByte’s support dept. to have it emailed.)

Back
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Problems related to launching or using the ImagePrint interface are listed in this section

ImagePrint won’t launch
•

Make sure that you have set up your printers using the IP Setup utility during the initial installation from
the CD. (You can double-check your installation by launching IP Setup from the ImagePrint folder on your
system: default location: c:\program files\imageprint(x86)).  If no printers are listed, then none have been
installed and ImagePrint will fail to launch.

•

Make sure that the ImagePrint folder has not been moved or renamed.  This folder must retain the same
name and location as it had after installation or the software will not run.

•

Make sure that you are launching the application from either a valid shortcut or directly from the ImagePrint
folder. Do NOT move ImagePrint’s application files to a different location other than the folder they were
installed to or they will NOT work. For information on ImagePrint shortcuts, see the entry in this guide entitled: After Installation, no icons appeared on my desktop.

•

If ImagePrint previously launched, then suddenly stopped responding, something may be corrupt in it’s settings.  Remove, then reinstall the installed ImagePrint printer via IP Setup by following the instructions in the
Reinstalling your ImagePrint printer driver entry earlier in this guide. (You will lose all old print jobs when
removing the printer).

•

Try right clicking the ImagePrint.exe file from it’s location in the ImagePrint folder (c:\program files(x86)\
imageprint) and in the menu that appears, choose “Run as administrator”.  If this works, you may have
security or permissions settings on your system that prevent your user login to launch Imageprint.

•

An invalid or corrupt monitor profile may cause this condition.  If you’ve profiled your monitor recently test
this by accessing your Windows Control Panels, choose Display, then Settings, then Advanced, and temporarily change the System Monitor profile to a standard working space (such as Adobe 1998). Remember the
previous profile so you can return to it later. Then try launching ImagePrint again. If it works, there may an
issue with your monitor profile. (ImagePrint supports only ICC version 2 (not 4) profiles, and only the Matrix
(not LUTS) type.

•

Removing ImagePrint completely and reinstalling may correct serious corruptions within the software.  
Consult the ImagePrint users manual (located in your ImagePrint folder) for information on removing and
reinstalling ImagePrint completely.

•

Anti-virus software or other security related software has been known to prevent ImagePrint from launching. Try disabling such software (or removing it temporarily as disabling often does not fully de-activate
anti-virus software) and launching again.

•

If all else fails, boot into SAFE mode and try launching ImagePrint.  If that works, some background process
(like anti-virus software or a device driver) is incompatible with ImagePrint. Disable or uninstall any nonessential processes in a process of elimination to locate the one causing the problem.
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Far and away, the most common problem with images failing to open is due to an illegal character in the file name
OR THE NAME OF THE FOLDER(S) THAT THE FILE IS IN. Check the name of the file (and the folder(s) the file
is in) for any character that is not a letter, number, underline, hyphen or space. Check the entire path of folders--any
problem character in any folder in the file path will cause the image not to open. Don’t simply check the file name-check each folder, and sub-folder, along the path containing the file for illegal characters. (Did we mention
that you should check the entire path?)
Problem characters include (but are not restricted to): parenthesis (), pound signs #, apostrophes ‘, ampersands &,
commas , , dollar signs $ and bullets •.   Also--make sure your files have the proper extensions in the file name for
their format.  (.tif (or .tiff), .psd, .jpg) or they will not be recognized as image files by ImagePrint.  As a test, try renaming your file to a simple name (i.e., test.tif, test.jpg or test.psd) and move it to your local computer’s desktop. Then
try to open it in ImagePrint. If it opens, then either something in the filename or pathname is causing an issue, or permissions on the original folder or drive the image was located in was the culprit.
If the image still fails to open, check the sections of this guide pertaining to problems with the file type you are working
with (JPEG, PSD or TIFF).   

Remember that ImagePrint only opens JPEG (RGB only), PSD and TIFF files. Other formats such as
PostScript, EPS, PDF, or Raw files are not supported.
Back

JPEG files won’t open (or open very slowly)
• Try re-saving the JPEG file from Photoshop, and make sure NOT to use “PROGRESSIVE” as the JPEG compression format. Also, only RGB JPEG files are supported (not CMYK JPEG files).

JPEG files are opening and printing at the wrong size!
Currently, ImagePrint treats all JPEG files as 300 PPI.  This is to avoid problems because of incorrect dpi data that
sometimes is saved by Digital Cameras. If they were created at a different resolution, try re-saving them at 300 PPI
to correct the size problem, or save them as TIFF or PSD files, which will use the correct dpi setting for the image.

Some windows (such as the Image Strip, Shuffle, etc) or SpoolFace not appearing when chosen
Display Change: If you are using a new monitor with a different resolution, or have recently changed the resolution
on your current monitor, or have gone from two monitors down to one, it’s possible that the window is being placed
outside of your current displayed area. To fix the problem, temporarily reset your monitor to the old resolution and
then manually move the windows back into range.
If a change in your display is definitely not the problem, or it is not possible to go back, you may need to delete
ImagePrint’s Registry key.  Note: deleting this key will revert most ImagePrint settings back to their defaults.  Follow
the procedure in this guide entitled: Deleting the ImagePrint Registry Settings to correct the problem.
Make sure that ImagePrint and Spoolface are NOT running before deleting the registry key.

Back
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• Make sure to check the general question regarding File Names earlier in this document--nothing but letters,
spaces, underlines, hyphens and periods should be in the file name.
• Make sure compression is not used when saving your images. ZIP compression is often turned on for
no discernible reason in Photoshop CS 3 even when it had previously been turned off so don’t assume that it
is off if you’ve never accessed it.  Do a “Save As...” in Photoshop on your image to ensure that no compression is used.
• The Pixel Order can also cause images not to open, or to open and display incorrectly or to open and print
very slowly.  In Photoshop’s “Save As...” dialog, in the TIFF options section, make sure the Pixel Order is
always INTERLEAVED, never “Per Channel”.  
• Alpha Channels: ImagePrint does not support non-color channels in TIFF files. Make sure that no extra
channels are present in your image. To check for extra channels, open the file in Photoshop. Choose
CHANNELS under the Photoshop Windows menu.  In the Channels palette that appears, you should only
see the standard  color channels (i.e., R,G,B for an RGB image).  Delete any extra channels and save a copy
of your image for printing.

Back

PSD (Photoshop) files won’t open (or print slowly)
• Make sure to check the general question regarding File Names earlier in this document--nothing but letters,
spaces, underlines, hyphens and periods should be in the file name
• In many cases, problems opening Photoshop files can be resolved by flattening the image in Photoshop prior
to opening it in ImagePrint. While layers often are fine, there are some layers that can cause problems--this
is especially true of “vector” type layers, like clipping paths or live text.
Newer versions of Photoshop (CS, CS2 and CS3) have modified their file format, and sometimes need to be
flattened before being opened in ImagePrint even if the same file, saved with a previous Photoshop version,
worked.
• Also, make sure that no extra (non-color) channels exist in the image.  To check for extra channels, open the
file in Photoshop.  Choose CHANNELS under the Photoshop Windows menu.  In the Channels palette that
appears, you should only see the standard  color channels (i.e., R,G,B for an RGB image).  Delete any extra
channels and save a copy of your image for printing.
• Try saving the file as a TIFF, or JPEG to avoid any issues with the Photoshop image format (which can
sometimes have Photoshop specific information that doesn’t work well with non-Adobe applications)

Back

Options button is grayed out in Dashboard->Advanced->Print Setup
This usually means that some needed libraries were not correctly installed. Try updating the software via the
Help -> Check for Updates option within Imageprint’s main menu.
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The Image Strip doesn’t work correctly
If the Image Strip doesn’t appear when you choose Image Strip from the ImagePrint View menu, there may be
a problem with its settings. This can happen if you’ve had a system crash, or if the File Browser was accessing a drive that is no longer available. Follow the procedure in this guide entitled: Deleting the ImagePrint
Registry Settings to correct the problem.
If the Image Strip appears, but shows no files or folders, check that you have chosen a folder that actually
contains supported image files in the IMAGE FILE LOCATION section of the Dashboard.  (ImagePrint supports jpeg, tiff and Photoshop psd files).

Remember--the Image Strip, while convenient, is not the only way to open files.  You can also drag
files directly from their Windows folder into the Imageprint layout area, or use the standard
File -> Open menu dialog.
Also, in most cases, Adobe Bridge can be used with ImagePrint.

Back
The Profile Valet doesn’t show any profiles!
1. The Profile Valet does not work with some older printers due to changes in the way the profiles are
indexed.  The Epson 9600, 7600, 4000 and 2200 (and older) printers do not work with the Profile Valet. For
those printers, the Choose by Profiles option can be used instead, and new profiles can be downloaded via
the Profile Manager (described in chapter 6 of the ImagePrint Users Manual).
2. If you are on a supported printer and the Profile Valet shows no profiles, the profile index files may be corrupt. Delete the indexes and relaunch ImagePrint as follows:
  Go to your ImagePrint program folder (c: / program files(x86) / ImagePrint)
Double-click the shortcut: ImagePrint Data Folder.
  In the folder window that appears, open the folder called “pindices”
  Delete all files within that folder (they will all end with a zip or xml extension)
  Relaunch ImagePrint and try the Profile Valet again.

Back
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Deleting the ImagePrint Registry Settings
ImagePrint maintains many of its settings in the Windows Registry.  If these settings become corrupt, problems may result, including issues with the File Browser, or settings windows that no longer appear on screen.
In these cases, deleting the ImagePrint registry entry may solve the problem. The registry entry will be rebuilt
the next time ImagePrint is launched with default settings in place.
Follow one of the below procedures to delete the ImagePrint registry settings.
NOTE: Any custom page sizes you have created will be lost as a result of deleting the ImagePrint Registry settings and will need to be recreated via the User Defined page size window within ImagePrint.  Also, your current
Color Management selections will be returned to their default state, so you will need to re-select your profiles
and settings within the Color Management window after deleting the registry entry. (You may want to record
those Color Management settings before proceeding so you can easily re-select them afterwards).
IMPORTANT: Make sure to close ImagePrint and Spoolface before removing the Registry entry.
Method 1 (preferred) - Deleting the ImagePrint registry entry via the ImagePrint Uninstaller
• Launch the Uninstaller by choosing it from your Windows Start Menu’s ImagePrint program group, or
launch it directly by double-clicking the “Uninstall.exe” file in its location within the ImagePrint folder (c:\
program files(x86)\imageprint)
• Click “Continue” when the Uninstaller window appears.  
• In the next window, make sure to uncheck the entries for ImagePrint Program Files and Color
Profiles, leaving only the Registry Entries selection checked. Click Continue.
• The next window will confirm that only the Registry entries will be removed.  After confirming that, click
OK to have the Uninstaller remove the registry settings.  
• Close the Uninstaller when it reports that it is complete
• Launch ImagePrint to see if the problem has been corrected.
Method 2 - Manually deleting the ImagePrint registry entry via RegEdit
Only use this method if the Method 1 reports a problem or the ImagePrint Uninstaller is unavailable
The Windows registry contains vital Windows system settings. Failure to follow these instructions
carefully could result in problems with your Operating System.
• Launch the Windows Regedit utility:  
Type regedit in the Windows Search field, and double-click Regedit.exe when it appears in the
results listing.
• When the Regedit window appears double-click the HKEY_CURRENT_USER folder in the list of folders
appearing on the left side to expand the list. Double click the Software folder icon, then the ColorByte
Software folder icon.
• Right-click the ImagePrint 10.0 folder icon and choose DELETE. That will delete our registry entry (it
will be rebuilt when Imageprint restarts).
• Restart ImagePrint and check if the problem is resolved.

Back

T22

IMAGEPRINT                                Troubleshooting

Back to Table of
Contents

ImagePrint Windows Troubleshooting Guide (Cont.)

Display Issues

Back to Table of
Contents

If images aren’t displaying on screen properly within ImagePrint, look here for solutions

Images appear split, reversed or in triplicate on screen
This condition can occur if you do not have a proper source profile chosen in the Profile section of the
ImagePrint PREFERENCES window (Preferences is found under “File” in the main menu at the top of the
screen). This problem is most often when using a grayscale paper profile or opening a grayscale image.
Make sure to have a valid gray profile selected in the Missing Profile section’s Grayscale field (either “Gray
gamma 1.8” or, most typically, “Gray gamma 2.2”).  Also, you should make sure the Embedded Action field is
set to APPLY if using embedded profiles in your images.  Without a source profile chosen, the software
will have no way of determining how to map the single channel grey data to the 3 color screen display, and distortion will result.
Also, in the same window, the “Press match” profile should be set to NONE unless you are specifically trying
to cause your output to match to a press (in which case the press profile can be used there).
In the vast majority of printing workflows, the Press Match profile should always be NONE.

Back
Images appear scrambled, low resolution, or full of artifacts
• Extra channels in the image may cause it to display incorrectly.  To check this, open your image in
Photoshop and check in the CHANNELS window that only the normal Color channels appear (no masking
layers or other non-color channels should be in the image).
• Some layers may cause problems.  Try saving a flattened version of the file from Photoshop.
• If no extra channels appear, and it is flattened, and it is a tiff file , try re-saving the image from Photoshop,
and in the Save... dialog box, make sure the “Pixel Order” is “interleaved” (not per channel) and that NO
compression is being used.
• If the display appears low res, check in the ImagePrint Preferences window (available under the View
menu) that Use Thumbnails is not selected.
• Remember, to get a higher resolution preview of the image, you can right click it and choose High
Resolution.
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Colorized B/W Images appear gray on screen
This is normal behavior.  On screen, the colorized image will display using only the GRAY profile, but when
printed, the colored portions of the image will use the selected COLORIZED B/W profile.

Back
Colorized B/W Images appear distorted
This is usually the result of the image being 16 bit, or containing an Alpha channel.  Only 8 bit RGB images,
with no alpha channels, are supported with this feature.

Back
Two monitor system and ImagePrint’s colors are not displaying correctly
If you are using a two monitor system, it is important to understand that ImagePrint will only recognize the
monitor profile for your System monitor. Therefore, if ImagePrint’s display is residing on a secondary display,
the monitor profile may be incorrect. It may be necessary to designate the secondary monitor profile as the
System monitor profile to have ImagePrint show colors properly on the second monitor.

Back
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Printing Issues (Also see Spoolface error codes)
Problems and questions related to printing and printing errors are listed in this section

Nothing Prints!
There could be many reasons for your jobs not to make it to the printer.  While other sections of this troubleshooting
guide lists more specific error conditions, here are the general things to check when you are unsure of the problem:
DEMO printing occurs when ImagePrint is running in “DEMO” mode due to the dongle not being available or the proper
printer encryption not being in place. You will get no output from the printer if a license issue is detected and you are
set to “Do not print in Demo” mode in Spoolface under the Queue menu.  Check the status area on the right side of the
spoolface window to see if an encryption/licensing issue is reported.
IMPORTANT: If using the LITE version of ImagePrint (available for 13 inch wide printers only) you will get DEMO or NO
OUTPUT if using any of the non-LITE features. Those features include: Templates, Color Correction tools, Backgrounds
and Frames. Multiple images on a boundary area will also cause demo with the LITE version.
•   Numeric Codes: For a list of common numeric error codes that may appear in SpoolFace, see the section later in
this guide: Spoolface Error Codes ·
• Wrong connection specified in IP Setup:  A major cause of printing problems is an incorrect Printer connection
(i.e., USB, firewire, Ethernet) having been specified in IP Setup when ImagePrint was originally installed. If you suspect this is a problem, reinstall the printer following the basic setup instructions earlier in this guide in the entry entitled: Reinstalling your ImagePrint Driver
• Un-pause the Queue: Make sure that the Queue menu at the top of the SpoolFace window is not set to PAUSED.
The spooler will pause if it encounters an error (such as running out of ink or paper) and it is important that you unpause the spooler after correcting the problem, or nothing new will be sent to the printer.
• Old Jobs in the way: Remember that the topmost job on the top of SpoolFace is the next to print. If that job
has a problem that pauses the spooler, until the job is dragged to the “done” side no other jobs will be able to print.  
• No Dongle: Make sure the Dongle is attached to the computer or a powered usb hub. No printing can take place
without the dongle attached.
• Roll vs Sheet: Make sure that ImagePrint is set to SHEET mode if you are printing to sheet (not roll) paper, and vicea-versa. The sheet setting is in the row of icons located in the Media Feed section of the Dashboard. If some smaller printers, if the sheet/roll setting is incorrect for the type of paper currently loaded, the printer will flash its red paper
light and never print, on printers with front LCD panels, a “Load roll/sheet” error will occur..
• ImagePrint settings issues: Many printing problems are the result of an incorrect setting within ImagePrint (usually
relating to Color Management or page size).  (Error 768 is a common error code that often indicates a color management issue). Make sure you have correctly specified your Color Management settings within ImagePrint’s Color
Management window.  (After making any changes, remember to move old jobs from the left side of SpoolFace, and
to un-pause SpoolFace from the Queue menu before attempting another print). For information on proper color settings, please see chapter 6 of the ImagePrint PDF manual.
• Check the Status: In no printing is occurring after clicking PRINT, make sure to check the status in SpoolFace, the
interface to the ImagePrint Spooler. (To launch spoolface, click the Spoolface icon at the bottom of the ImagePrint
floating toolbar). In SpoolFace, make sure that the Computers menu shows the computer that is connected to the
printer selected, and the Printer menu shows the correct printer. Check for pertinent errors within Spoolface that may
shed light on the problem. The bottom left corner of the SpoolFace window will show the current status of the printer
(for example, Active-IDLE), and the scrollable area on the right of SpoolFace will list job error messages.  Make sure
to read through this section for information that might show the cause of the printing problem.
• Nothing appears in Spoolface: 1.) First, make sure you have the right printer selected in the PRINTERS menu at
Continued on next page
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Nothing Prints (Continued)
the top of the SpoolFace screen! 2.) If you have recently upgraded the Operating System, ImagePrint libraries
may have been overwritten. To fix that, try checking for updates from ImagePrint’s Help menu. 3.) This condition
can also happen if IP Setup was used to install an ImagePrint printer while SpoolFace and/or ImagePrint were running in the background.  This will often cause things to seem fine, but, when PRINT is clicked, jobs won’t go to the
spooler with no error message generated. The solution in that case is simply to close SpoolFace and ImagePrint,
relaunch IP Setup (from the ImagePrint folder) and remove, then reinstall, the printer(s). 4.) Anti-virus software
or other security software might prevent jobs from making it to spoolface.  A new option (as of version 8.0, build
1.0.0.5) has been added to ImagePrint’s Preferences window--”Print Directly to Print Spooler”--enabling that
option may allow jobs to go to spoolface as it uses a method of foreground printing not (usually) blocked by security or anti-virus methods. If that option fails to correct the problem, try disabling any anti-virus software--Note:
because disabling often leaves anti-virus components still running, you may need to uninstall the anti-virus software to ensure it is still not blocking the printing processes.  On Windows 7 and Vista systems, UAC (User Account
Controls) can sometimes block ImagePrint from printing.  UAC settings can be adjusted via the User Accounts
Control Panel accessed from your Start menu.
• IP BATCH Error: If an “IP Batch” error message appears after sending a job to print, check the following:
Make sure you have chosen the correct profile settings in the ImagePrint Color Management window.
Consult chapter 6 of the ImagePrint user’s guide for instructions.
Make sure you have selected a Media Type in the ImagePrint Options menu (accessed by clicking
OPTIONS in the Print dialog) for printers that support that feature.
If printing from a networked Client to a Host computer, make sure the printer/paper profile chosen on
the Client is available in ImagePrint’s COLOR folder on the Host computer as well.
In rare cases, a problem with the dongle can cause an IP Batch error. This typically occurs with older
dongles used with ImagePrint 5.6 or below that have never successfully been used with ImagePrint 8.0.
If this is the case on your system, contact ColorByte support for more information.
• Print to File: Make sure the Print to File option is not selected in the Dasboard->Advanced->Print Setup section or
no output will be printed (only a tiff file containing the layout will be saved).
• NETWORKED PRINTER PROBLEMS: If your printer is connected via Ethernet, the usual reason for print failure is an incorrect IP Address specification for the printer in ImagePrint’s settings.  If the printer’s IP Address has
changed since installing ImagePrint, ImagePrint will no longer be able to find the printer until it is changed back or
ImagePrint is updated (via IP Setup) to reflect the new IP address. For information on accessing and changing the
printer’s IP Address, check the entry in this guide entitled: Networked printer settings. Once you know the current IP Address of the printer, double-check that the same IP Address was used in IP Setup (launch IP Setup, and
check the IP Address shown in the printer’s listing (it will have /9100 after it).   If it is not correct, reinstall the printer
using the instructions at the beginning of this guide entitled: Reinstalling your ImagePrint Driver.

Back

Nothing appears in SpoolFace when PRINT is selected
See the Nothing Appears in Spoolface section in the previous entry (Nothing Prints).
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Printer outputs garbage text
This condition occurs when bad data or partial data is sent to the printer, causing the printer to go into “text”
mode. Since turning off the printer can still leave stray data in the buffer of the computer, and turning off the
computer can still leave stray data in the printer buffer, it is advised that to correct this condition you power
down both the printer and the computer to ensure that neither device retains any partial data in its buffer.
(Make sure to disable the ImagePrint queue before powering down the computer by choosing DISABLE from
the QUEUE menu in SpoolFace). Then, turn the computer and printer back on. Un-pause Spoolface (choose
QUEUE->Pause to remove the checkmark beside the Pause entry) and try sending a new job to the printer.

Back
“Load ROLL” (or Sheet) Paper message on printer
This message appearing on the printer means that ImagePrint set to a paper type (sheet or roll) that is not
currently loaded in the printer. Make sure the correct setting is in place in the ImagePrint Dashboard, in the
Media Feed section.
Likewise, make sure the printer’s control panel (on the front of the printer) is set to the right mode for the currently loaded paper type.  (Often, pressing the Roll/Sheet button on the printer when this error occurs will let
the job continue).

Back
“Forbidden Media” message on printer
This message, on the front console of the printer occurs when the printer rejects paper as illegal to load in
the paper tray. Only certain papers are certified to work with the printer tray. If you wish to have the printer
use the loaded paper anyway, choose another paper as the “Media Type”  by clicking Options within the
Dashboard’s ADVANCED->Print Setup section.  Media Type settings control the paper feed controls of the
printer--pick one as close as possible to the thickness of the paper in the paper tray to avoid banding issues.

Back
“Reload Paper”/”Paper Out” message on printer
“Reload Paper messages often mean the paper loaded in the printer is NARROWER than the page size specified in ImagePrint.  You can correct this by specifying a smaller page size in ImagePrint, or, by disabling the
“Check Sheet Size” option in the Printer’s front control panel. In some cases, manufacturers ship paper that
is incorrectly sized, so make sure to measure your paper to ensure it is the size stated on its packaging--even
small differences in size can cause this error to occur.
“Paper Out” messages, or the paper feeding through the printer without printing, typically occurs if the paper
in the printer is SHORTER than the page size specified in ImagePrint.  To correct, specify a page size in
ImagePrint that is the same as the physical paper’s length or shorter. (Double check by measuring the actual
paper--some manufacturers can be slightly inaccurate in the dimensions specified on the box).
Another cause of paper feeding right through the printer without printing is a paper sensor issue.  Make sure
to use a clean sheet of paper, as the printer’s sensors check for paper white and can be fooled by previously
printed images on a page.

Back
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“Wrong Page Size” message on printer
If the message “Wrong Page Size” appears on an Epson printer when attempting to print, it is due to the
printer sensing a different page size than that being specified by ImagePrint.  Printers can be very sensitive
to slight differences in page size, especially when loading thicker paper types.  In some cases, manufacturers
ship paper that is incorrectly sized, so make sure to measure your paper to ensure it is the size stated on its
packaging--even small differences in size can cause this error to occur.
One way to avoid that error is to turn off the “Page Size Checking” feature of the printer.  This will cause the
printer to no longer check the page size when printing.  To turn page size checking off, on the Epson’s front
control panel, use the Menu button to enter the Printer Setup section. Use the up and down keys to find the
“Page Size Chk” entry.  Hit the right arrow button to access that setting, then use the UP arrow to toggle to
OFF and hit the Enter key.  An asterisk will appear next to the word OFF showing it is now in effect.  Then use
the right arrow button repeatedly to get back to “Ready”.  NOTE: Turning off he “Page Size Chk” setting may
cause prints to not be centered correctly when sheet paper is loaded manually on the printer. (Often, pressing the Roll/Sheet button on the printer when this error occurs will let the job continue)

Back
SpoolFace generates an error when launched
If you get a “Connect” error, or an immediate crash when launching spoolface, most commonly the problem is
a necessary background process (muxd.exe) not running.  During ImagePrint’s installation, MUXD.EXE is set
to automatically launch each times Windows starts, but Anti-virus prorams sometimes prevent the automatic
launch from happening, or even delete the muxd.exe file entirely. It is beyond the scope of this manual to
provide support for the myriad anti-virus products available, but check your anti-virus logs to see if there’s a
report of muxd.exe being blocked.  The Windows Firewall can also block muxd.exe, so check its settings as
well.  You may need to set an “exclusion” for the \program files (x86)\ImagePrint folder within your antivirus
software settings to prevent the software from interfering with ImagePrint.
Note: Even if your anti-virus software has worked with imagePrint in the past, it doesn’t mean it can’t change
with no warning. Antivirus software can update their virus definitions at any time and suddenly misidentify
muxd.exe (or another ImagePrint component) as suspicious.
You can manually launch muxd.exe from it’s location within the ImagePrint/spool/mux folder.  Just go to
        c: \ program files (x86) \ ImagePrint \ Spool \ Mux
and double-click muxd.exe.  A brief window will flash as the process is put into the background.  Then
Spoolface should work, at least until you reboot windows.
If, after rebooting, spoolface shows a problem again, chances are your firewall or antivirus software is stopping muxd from automatically launching again--you can manually launch it per the above steps again each
time windows boots, or track down what anti-virus software on your system is blocking it (or firewall). If you
can’t determine the culprit, try putting a shortcut for muxd.exe in your Windows startup folder to have it automatically launch that way (which may avoid the anti-virust block). To do that: Right click the muxd.exe file, and
choose Create Shortcut in the menu that appears, then copy that shortcut (NOT MUXD.EXE itself into your
Windows startup folder.  Finding the startup folder varies annoyingly according to your version of windows, but
to get there on Windows 8 and 10, click start, type %AppData%  and hit return, then double-click the folder
that appears and navigae to:
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    ...Roaming\Microsoft\Windows\Start Menu\Programs\Startup
No Muxd.exe found!
If muxd.exe can not be found in your Imageprint \ Spool \ MUX folder, it’s probable that your anti-virus
software deleted or quarantined it as a suspicious file.  To get it back, you can perform a “repair” from the
Windows “Programs and Features” Control Panel.  Choose “ImagePrint v10” within the Programs and
Features list, and choose “Repair” (Not uninstall!) and muxd.exe should be returned to the proper folder,
though if may disappear again if your anti-virus software is still active.

No printers found error when launching Spoolface
You may also see a “No Printers available” message is your are on an ImagePrint CLIENT computer.  This
is normal behavior, as the spooler is trying to find a printer on the local machine.  Just choose COMPUTER  
(from the SpoolFace menu), and pick the IP Address or computer name of the ImagePrint HOST computer.
If there is no PRINTER or COMPUTER menu at the top of the screen when SpoolFace is active, there is a
problem with the installation. Close SpoolFace and ImagePrint, then re-launch IP Setup (from the ImagePrint
folder), remove and reinstall the printer(s). Be aware that removing printers will delete all old print jobs for that
printer!

Back

Epson 2200 or 2400 doesn’t print, red paper feed light shows
This is typically caused when ImagePrint is set to the wrong paper mode (sheet vs roll). The 2200 and 2400
are picky about this setting, and if ImagePrint is set to the wrong one for the type of media loaded in the
printer, the result is no output, and a red light on the printer. Make sure the Roll/Sheet icon, in the bottom right
corner of the main ImagePrint window, is set correctly to Sheet. (Hover your mouse over those icons to see
their function)

Back

Warning: Unknown TAG (or other Warnings) in SpoolFace
Warnings such as UNKNOWN TAG are not critical.  These are informational displays and can be ignored.  
Almost all TIFF files will report “Unknown TAG warnings”.

Back

I keep getting extra jobs sent to spoolface
This is the result of additional pages existing in the ImagePrint layout window. This can happen if AutoFlow
is enabled and you have added images to your layout without first deleting previous images via the scissors tool--new pages are generated for new images when there is no room on the current page and by
default, ALL images on all pages will print when PRINT is selected. Autoflow can be turned on and off via the
AutoFlow checkbox in the Dashboard’s ADVANCED->Auto Layout Settings section.  
To delete ALL images from all pages, click the Red scissors icon in the Floating toolbar.

Back
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Printer flashes lights, or generates Command Error when attempting to print
This error is caused when ImagePrint is set to an inkset other than that currently in use by your printer. This
can happen if you have selected the wrong Printer/Paper profile for the black ink type you are using (Matte or
Photo) in the Profiles section of the DASHBOARD.  
The Printer/Paper profile is responsible for determining the ink set used in the job--picking a profile made for
an ink set not currently installed on the printer will cause this error occur.

Back
“Can’t print scanlines” error, jobs go into the spooler but never print
This is usually an issue with the connection to the printer. Confirm that you designated the correct port for
your printer during the installation (you can double check this setting by launching the IP Setup utility and seeing what is listed in the Installed Printers area for your printer. The device selection will show up within the
parenthesis in the printer line. If you suspect the wrong connection was specified, try removing and reinstalling the printer according to the Re-installing your printer entry earlier in this guide.

Back

Couldn’t Set Up Watch folder
If printing from a networked CLIENT computer, this message typically means the PRINTER NAME used when
installing ImagePrint on the CLIENT doesn’t exactly match the PRINTER NAME used when installing on the
host. Launch IP Setup from your ImagePrint folder on the CLIENT and make sure the installed printer matches that shown on the HOST. If not, remove and reinstall the printer on the client with the correct name.
If you are NOT on a remote Client and you see the “Couldn’t Set Up Watch” folder error, that typically means
your printer spool folder structure is corrupt. Possilbly due to a failed printer installation that couldn’t write
files to your hard drive because it did not have permissions, or pre-existing files it needed to overwrite were
busy when IP Setup was run Usually, removing and reinstalling the printer via IP SETUP will correct this
problem (you will lose your old spooled jobs however when removing the printer).

Back

Print Jobs move quickly to the finished side of the spool face window before the job prints.
Epson Driver stealing the job: The EPSON Stylus Windows driver can sometimes intercept jobs going to
the port it is using.  In this scenario, jobs sent from ImagePrint are put into the Windows spooler and no longer monitored by Spoolface. Jobs should always stay on the active (top) side of the spoolface window until
just before the printer is done with them.
You can check for this condition by right clicking the EPSON Stylus driver for your printer in Window’s Printer
and Faxes list, and choosing PROPERTIES in the menu that appears.  In the Advanced section of properties window, make sure it is set to Print Directly to Printer. (Note: you should check the EPSON Stylus
driver--NOT the ImagePrint driver that may also exist in Printer’s and Faxes. The EPSON Stylus driver
will typically have STYLUS in its name, and is put there by EPSON. )

Back
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“Couldn’t Spawn Queue Command” error when clicking print
Computer name change: This error indicates that ImagePrint is not able to communicate with its spooler. The
most common cause is a change in the name of the computer since the printer was installed via IP Setup. If you
have changed your computer name, it is necessary to run IP SETUP again to remove, then reinstall, the printer (the
new computer name will automatically be used for the new installation). Important: Make sure that ImagePrint and
Spoolface are not running when reinstalling your printers via IP Setup.
Host/Client printing: This error can also occur when printing from an ImagePrint CLIENT to an ImagePrint HOST
computer if the two computers can not see each via the TCP/IP network protocol.   Firewalls or anti-virus software
may also prevent the Client from communicating with the Host.  You should also check via the Windows Task Manager
that the “muxd.exe” process is running on both the Host or Client (muxd is necessary for client/host printing to take
place). Check the section: Problems printing from a networked client for information on troubleshooting problems
in this area.

Back
How do I print directly from an Application like Photoshop, InDesign or Illustrator?
IMAGEPRINT allows you to print directly from virtually any other application, including Photoshop, InDesign with the
optional PTA (Print Through Applications) feature. Application level printing is installed when you install either the
Windows or Macintosh version of IMAGEPRINT but must be licensed to run in non-demo mode..
NOTE: It is recommended for troubleshooting purposes that before using application printing, you confirm that you can
successfully print directly from the ImagePrint application first.
Information on PTA is in the PTA chapter within the ImagePrint users manual, along with Troubleshooting information
for common problems.

Back
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Problems printing from a networked client
A Client installation of Imageprint will run the normal ImagePrint interface, but, when Print is selected, will send all
of its jobs to the ImagePrint HOST computer (the Host is always the computer with the DONGLE attached). When
installing a client, remember that the Client does not need to be licensed in IP Setup (even if it shows “disabled” or
“unlicensed” in the IP Setup window). All licensing is handled by the HOST at print time, so only the HOST computer needs to be licensed.
Below are things to check if you experiencing problems printing from a client to a host:
1.

Make sure that the Host computer can print directly to the printer first to rule out a problem with the printing in general.

2.

Make sure that the Client computer can “see” the Host across the network via Network neighborhood, or
“pinging” it via a DOS or OSX Terminal window.
To “ping” the remote computer from Windows:
		

Open a DOS window (choosing START->RUN, and typing in “Command” and 			
hitting Return is one way to launch a DOS window).

		

In the DOS window, type in the following command and hit return:

		
ping “computer name”
					

(Where “computer name” is the name (or if pinging a 		
Mac, the ip address) of the remote computer.)

Check the messages that appear after typing the ping command to see if the 				
remote computer can be reached from the host. Error messages indicate a net				
work problem that needs to be addressed before ImagePrint can utilize network 				
printing.
3.

Firewall settings, on either the Host and Client, can block ImagePrint from sending jobs. Try printing
from the Client with the Firewall disabled. Also, security software like Zone Alarm, or anti-virus software,
may be blocking the TCP/IP port that ImagePrint uses for network communication. (ImagePrint uses port
1 for it’s client/host printing).

4

If the Host can print, but jobs from the Client do not appear in the Host’s SpoolFace window, make sure
that you specified the name of the Host computer (or the IP Address if the Host is a Macintosh) when
installing ImagePrint on the Client. To double-check, launch IP SETUP and see what setting is listed
in the HOST column for the printer. If it does not show the proper computer (the Host computer should
be the computer with the dongle) If incorrect, delete the printer using the DELETE button in IP Setup,
choose the printer type again, choose CLIENT as the installation type, enter the NAME of the Host computer (or ip address if the remote computer is a MAC) and click INSTALL. Important: Make sure that
ImagePrint, and SpoolFace, are NOT running when you perform this reinstall.

5.

Couldn’t set up Watch Folder: If you receive this error, it’s likely the PRINTER NAME you specified
when installing ImagePrint on the CLIENT does not exactly match the name you used on the HOST.

6.

If you are receiving a message along the lines of “Can’t write file”, or ERROR 97, you may have a permissions issue. When CLIENT jobs are sent to the spooler, all images within the job are written as temporary files to the HOST computer in the Spool/printers/”printer name” foler within the ImagePrint USER
DATA folder (accessed via the shortcut by that name in the “/program files(x86)/ImagePrint” folder). If
that folder is not accessible, you may get this error. Make sure that the IMG folder exists, and has full
write permissions. Also, make sure you have ample hard disk space on the HOST computer.

7.

The process “muxd.exe” must be running on each Windows computer (host or client) in order for communication to take place. You can confirm that this process is running via the Windows Task Manager
(hit Control-Alt-Delete to access it). If muxd.exe is NOT running on either computer, it can be manually
started from it’s location in the /Program Files(x86)/ImagePrint/ SPOOL/MUX folder. (This process is
set to start automatically when ImagePrint is installed).

Back
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Normally, dragging a job from the top (“Active”) pane to the bottom (“Finished”) pane should cancel it.  If the job will
not move over, it means that the printing process is not being allowed to quit normally by Windows.  To force the job
over, do one of the following:
1.

The cleanest way to handle this condition is to PAUSE the queue by choosing Queue->Pause from the
Spoolface menu, then reboot the computer. The job should move over with no problem when the system
comes back up. (It is important to pause the queue first, to make sure the spooler doesn’t attempt to print
again as soon as the system reboots.) After rebooting and moving the job over, remember to re-enable
the queue by choosing “Pause” from the same menu to get rid of the check mark beside the Pause entry.
This method is the cleanest, as it will reset the computer ports.
Although the following method will also work to clear the job from spoolface, if the computer ports are
“hung”, you may still have trouble printing until you reboot.

2.

Access the Windows task manager by pressing Control-Alt-Delete. Click TASK MANAGER, then
PROCESSES. Choose either the printer driver executable (i.e. epson10000.exe) or the process “ipbatch.
exe” and click the “End Process” button. The job will immediately move over in spoolface.

Back
Old computer names appear in my SpoolFace Computers menu
To remove any old computer names from the Spoolface COMPUTERS menu, close spoolface and locate the file “ip
hosts” located in the Spool folder within the ImagePrint folder.  Edit the “ip_hosts” file using a standard text editor such
as notepad and delete any lines containing unwanted printers and resave the file, then relaunch Spoolface.

Back
Connect 10061 Error when attempting to launch spoolface
This error indicates a background process, muxd.exe, is not running.  “Muxd.exe” is set via a Windows Registry entry
to run in the background each time your computer boots. If you receive this error, it is likely that an anti-virus or security program is preventing it from launching.
To test that this is indeed the problem, try launching muxd.exe manually.To manually launch muxd.exe, go to the following folder on your system:
c: \ program files(x86)\ ImagePrint \ Spool \ Mux
In the Mux folder, double-click “muxd.exe” to launch it (you will see a quick flash but nothing else).  Then, try launching
Spoolface again.
If launching muxd.exe manually allows you to launch Spoolface without error, ImagePrint and Spoolface should function normally until your next reboot. Of course, manually launching muxd.exe each time your computer boots is inconvenient.  If you find that the “Connect 10061” error returns after rebooting, you should check your anti-virus software
to make sure it’s not blocking the muxd.exe process.  You can usually set “exceptions” in anti-virus programs that will
allow specified programs to run, so you may need to do that if you discover your anti-virus is blocking it.
Advanced info: The default registry entry to launch muxd.exe is put in place during ImagePrint installation. The
Windows Registry entry Key is:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run
With value name: CBSpoolDaemon

And value data: “C:\Program Files(x86)\imageprint\spool\mux\muxd.exe”

Back
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When there is a problem printing, Spoolface usually shows a text or numeric error code that can be referenced
in this section.  Always check the right (status) side of Spoolface for information regarding printing errors.  The
bottom-most text is the newest.  Look for anything in RED, and any messages that clearly state that an error has
occurred.  Also, the bottom LEFT corner of spoolface shows the current spooler status or the status of the last
failed job.

ERROR 1
This error typically means a software corruption of some type and may require removing and reinstalling the software.
It can also occur if an illegal character (such as a space) was used in the PRINTER NAME when installing via IP
Setup, or if anti-virus software is running on your computer that is interfering with ImagePrint’s printing processes. If
you do have anti-virus software, try disabling it and see if the problem persists.
If there are spaces or non-alphanumeric characters printer name you used when installing via IP Setup, remove
and reinstall the printer via the instructions earlier in this guide: Reinstalling your Imageprint Driver - A Basic
Walkthrough making sure not to use spaces in the printer name.
If removing and reinstalling the driver via IP Setup fails to solve the problem, try removing ImagePrint completely
and reinstalling according to the instructions in the ImagePrint Users guide.

Back
ERROR 2 or ERROR 15 (Printer not found)
This indicates a problem communicating with the printer. Make sure the printer is on and online. Make sure that
you specified the correct connection setting when installing ImagePrint (you can double-check this by launching IP Setup and seeing what is listed in the Installed Printer’s area for your printer. The device selection will show
up within the parenthesis in the printer line--it will either be the port the printer is connected to (i.e. USB001) or
the name of the Windows Printer driver you chose when installing (ImagePrint will use whatever port that driver
is using when installed in this way) or the IP ADDRESS of the printer (if connected via Ethernet to the printer).  If
in doubt, try removing, then reinstalling printer using the instructions in the entry at the beginning of this
guide: Reinstalling your Imageprint Driver - A Basic Walkthrough
If you’re sure the connection was specified correctly and you still get the error, you may have a device driver problem. Try printing from the printer manufacturer’s driver via the Test Page option within the Printers and Faxes driver
for that printer. If that also fails, switch connection cables to ensure there is no problem there, and make sure to
reboot both the printer, and the computer to reset both interfaces.
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ERROR 37
This indicates the dongle is not seen by the PC. No printing can take place without the dongle attached to a USB
port on the computer or a USB hub.
If the dongle is attached, launch IP Setup (from your ImagePrint folder) and see if the 6 digit dongle number
appears in the Dongle Number field. If the number shows up, then the dongle is being seen, and you should be
able to print.
If the dongle number doesn’t appear in IP Setup, try unplugging the dongle and re-plugging it back in (or try another USB port) then close and re-open IP Setup to see if the dongle number shows up. If that fails, reboot the computer and check IP Setup again. If the number still fails to appear in IP Setup, run through the suggestions listed in
the following entry of this guide: Dongle never shows up in IP Setup. Finally, try installing ImagePrint on another
Back to Table of
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computer (no printer needs to be connected for the test). If the dongle number fails to show up on the second computer, the dongle may be malfunctioning. Contact ColorByte’s support dept. for information on replacing the dongle.
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ERROR 97
This is a file access problem—the spooler is not able to access the file to be printed.
Make sure the file(s) to be printed is still accessible. Deleting a file or moving it from its folder after clicking
PRINT in ImagePrint before the image has actually printed can cause this condition as the Spooler will not
be able to access the file. Having your files on a cd, and ejecting the cd before the printing takes place, will
cause this as well. All the images on the page must remain in their original location while the page is printing.
If your images exist across the network, try moving it to a local directory and reprinting to confirm a network
access issue is not the cause.

Back

ERROR 163
This usually indicates some kind of connectivity problem with the printer.
- Make sure that the way you are connected to the printer corresponds to the connection type specified in IP Setup. Try removing the printer via IP Setup, and reinstalling (follow the Re-installing the
printer instructions earlier in this Trouble Shooting guide).  If using USB or Firewire, click the “Choose
Port” button in IP Setup, and try using the “Windows Printer Name” as the connection type.
- Make sure that you have specified a “Media Type” for the printer (for printers that support this
option--most printers other than the Epson 2200 do). To specify the Media Type, choose OPTIONS
in the Print dialog to have the Options window appear. If the Options button is grayed out on a supported printer, consult this entry: Option button is grayed out in ImagePrint print dialog.
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ERROR 609
This error is usually caused by one of the following:
* The image being printed no longer is accessible. This can occur if you’ve deleted or moved the actual
images within a job before it begins to print, or, if images located across the network are no longer
accessible across the network at print time. Loading images into ImagePrint from a CD, clicking PRINT,
then ejecting the cd before printing occurs would also cause this error.
* There is a non-supported channel in the image file you are printing. (Masking channels are not supported by ImagePrint.) To check for extra channels, open the image in Photoshop, and choose Windows>Channels. In the channels window, make sure only the standard color channels are listed (i.e., R,G,B).
Try deleting any extra one’s, save a copy of the image, and try printing again.
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ERROR 611 or 104 or 99 or “Out of Disk Space error”
Over 2 gig temp file: This error may occur if the dimensions of the print you are making causes a temporary
file to be made that exceeds the ImagePrint 2 gigabyte limitation.
You may also see an error in Spoolface that indicates there is not enough disk space to process the image
when you know there is plenty--this incorrectly reported error condition can be caused by the temporary file
exceeding the 2 gig limit.
If you are printing a very large, banner type of image and are seeing this error, try setting the Resolution setting (located in the ImagePrint Print dialog box) to 180 rather than the default 360. This will reduce the total
amount of data sent to the computer, with a slight reduction in quality (This very slight loss in resolution is not
visible from more than a few inches away, which is typically fine for banners and large posters.)
You may also be able to avoid this error by preventing ImagePrint from needing to build a temporary image at
all. Most jobs do not require a temp file be created, If possible, don’t rotate the image in ImagePrint (rotate
it first in Photoshop), and avoid the use the Step and Repeat feature when making extremely large prints.  
Rotated images will always generate a temporary file, as will Step and Repeated images and any prints that
use the Tiling Across Pages feature.
Out of disk space  Another cause of the problem may be that you are running out of disk space to process
the images. Large temporary files may be created if images on the page have been rotated 90 degrees, or
you are using the step and repeat function. If you encounter this error, increase your disk space by deleting
unnecessary files.  Rotating the images first, before bringing them into ImagePrint, can also prevent the need
for the temp file to be built.

Changing the temporary file location
Changing the location where ImagePrint stores its temporary files to a hard drive with more space is one solution to storage problems. To change the directory in which ImagePrint writes temp files (needed when images
are rotated 90 or 270 degrees), edit the file “ipbatch.bat”, located in the  ...printers\”printer_name” directory off
of the ImagePrint software directory, and add the line: “PRINT_TMP=directory” entry to the end of the file to
reflect the new directory.  (For example, set the PRINT_TMP=d:\temp)

Note that any new temporary file location should be on a local drive, not one located across the network!

Back
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ERROR 653
A wrong setting in the print job being sent from ImagePrint most likely causes this error.  Check that the
selected INKSET (which is usually determined by your paper profile choice in the Profile section of the dashboard) is correct for what is loaded in your printer.

Back

ERROR 768
This error can have a few causes
- MOST COMMON: In the Profile Section of the ImagePrint Dashboard a profile should be selected and
APPLIED that is correct for your printer and ink.
-  Check the PROFILES section of the ImagePrint Preferences window (chosen from the FILE menu at the
top of the screen) to, make sure that an appropriate source profile for your images is selected for each
color space that your images use within the Missing Profile/Untagged Images section (RGB, CMYK,
Grayscale).  For printing single-channel grayscale images, make sure to pick either “gray gamma 1.8”,
or “gray gamma 2.2”, in the Grayscale field.  It is almost always recommended that APPLY be set in the
Embedded Profile action field.
- An incorrect ink set setting can cause this error to occur as well.  Normally, when choosing a Printer
profile the proper ink set will be automatically selected. If using a profile that was not created by
ColorByte, it will be necessary to manually choose the correct ink set prior to printing via the Setup window, accessed from the Print Dialog box.
- A sub-folder, within ImagePrint’s COLOR folder, can also cause error 768.  Make sure only color profiles
are present in the COLOR folder, and that no sub-folder’s have been placed there.

Back
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ERROR 107############
A long (8 digit or more) error number (usually beginning with 107) is what happens when an error condition took place that ImagePrint wasn’t able to generate a proper error code for. Usually this means that
ImagePrint’s memory state was corrupted. The usual reasons for this are:
- An empty page has been sent to the spooler. This is often the result of additional pages inadvertantly
existing in the layout window. Check in ImagePrint that you are on the expected page. That information
is listed in the bottom of the ImagePrint window--for example “Page 2 of 2”. Remember that if AutoFlow
is turned on, each time you add an image to the layout window, it will generate a new page if the image
can’t fit on the current page. When you choose PRINT, all pages will be sent to the spooler if you don’t
select a range of pages in the print dialog.  To turn off AutoFlow (causing images to stack on top of each
other when they can’t fit on the page) de-select the checkbos in the Automatic Layout Settings section
of the Dashboard (under ADVANCED).  
		 To delete an unwanted page from the Imageprint layout, move to that page via the page controls in the
bottom left hand corner of the ImagePrint window, and click the Red scissors icon in the Floating toolbar.
- Another cause of this error is if one of the profiles you are using (usually the Printer/Paper profile) has
a filename that is too long if you are using a custom profile (one you made yourself--not supplied by
ColorByte). This is especially a problem on Macintosh computers. Make sure that the full name of the
profile (including the “.” and extension) is no more than 31 characters.  Unsupported non-alphanumeric
characters, like “&”, or commas, in the profile or image filename, can also cause this problem.
- If printing with templates, a corrupt template can cause this problem. Try printing without a template
applied to see if it corrects the problem.
- Corrupt images, images with extra channels (as seen in Photoshop’s CHANNELS window), images
saved with compression, or images saved with the Pixel Order set to “Per Channel” all may cause this
error to be generated.
- Too many images on a page:  Although it can be highly dependent on RAM, processor and image
type, its recommended that you limit the number of images to 40 or so per page to avoid overly taxing
system resources. If you need to print more than that, split them up between pages (you can use the
AutoFlow function to have images automatically “flow” to a new page when the current one is full).  
- CLIENT/HOST printing: If printing from an ImagePrint networked Client to a Host, make sure that any
profiles you’ve selected on the Client computer are available on the Host computer (within ImagePrint’s
COLOR folder) as well.  Otherwise, when the Host attempts to print the job, it won’t have access to the
specified profile and will cause this error.
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Output Quality Issues
Look in this section if you are able to print, but you have questions regarding the quality of the output.

My output is darker than it appears on screen
If colors are correct, but the overall print seems dark compared to the ImagePrint or Photoshop display, it is most
likely caused by your LCD monitor being too bright.
Many LCD monitors are factory calibrated overly bright in order to compensate for the typical LCD’s problems
with rendering shadow detail. Even if you have custom calibrated your monitor, it is very likely that it is brighter
than the “standard” CRT monitor of the past.
Simply physically dialing down the brightness of the monitor, using it’s on screen controls, is usually the solution
to this issue.

Back
Color cast in prints
Nozzles: As with any color issue, make sure you have done a nozzle check on the printer, and that all nozzles
are clean.  Nozzle issues are the chief cause of cast problems.
Profile temperature: The two most common color temperatures to use are EDAY (daylight) and ECWF2 or F3
(mixed lighting).  We have seen many users using the EDAY profiles and viewing under fluorescent light--this will
cause a magenta cast most noticeable in blues.  The F2 (ECWF2) and (if available) F3 profiles are more accurate for viewing under mixed lighting conditions and most likely will remove the magenta cast you see with the
daylight profiles.
Color Management settings: Check your ImagePrint Color Management settings.
n the ImagePrint Dashboard, in the PROFILES section (either the Profile Valet or the Choose by Profile
Name section):
- Make sure a correct printer/paper profile is selected for your paper and applied.  
In ImagePrint Preferences (found by choosing File in the Main Menu) choose PROFILES and
- Make sure Embedded Action is set to Apply
- Make sure that your normal Photoshop working spaces are selected in the Missing Profile 		
section for each color type.
Color Management workflow: Images that have been incorrectly color managed can show a cast when printed.
For more information on this, please see the Consistent Color Management Tips section in this guide.

Back
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Images are not centered on page
In the following, orientation is always relative to the observer facing the front of the printer. For example, Top refers
to the leading edge of the paper as it comes out of the printer, Left refers to the left edge of the paper as it comes out
of the printer.
• Top/bottom differences on sheet paper: Most printers have different top and bottom margins when using
sheet paper. This fact can cause images to appear off center vertically when printed. (The Epson 2200, 2400 and
3800/3880 are exceptions to this and allow equal top/bottom borders on sheet, but all other Epson printers have a
1/8th inch top and 5/8ths bottom margin on sheet).
To compensate for this limitation you can choose Center Margins from the Margin Styles section of the Dashboard.
This will cause the size of the smaller top margin to increase to that of the larger bottom margin, reducing the total
printable area while compensating for the difference in margins. If you then choose to center your images, they
should print with equal top and bottom borders. Make sure to readjust any existing images on the page after changing this option, as the change in layout size will shift things. And be aware of the smaller page size--with Centered
Margins turned on, there is 4/8th of an inch less vertical printable area available on the page for most
Epson printers. The Centered Margins setting has no effect when set to ROLL paper.
• Paper Feed: Another potential cause of Top/Bottom centering issues is an incorrect setting in the Media Feed section of the OPTIONS dialog (for printers that support it). Options is accessed via the Print Setup section of the
ADVANCED Dashboard area.  Normally, the Media Type is selected automatically when a paper profile is chosen,
but you can override that setting if your paper is thicker than the standard thickness of the profiled paper. For thicker
papers, select the closest match to your paper to ensure that paper is fed correctly.  Ultra Smooth Fine Art Sheet is
typically the thickest option available.
• Roll or sheet setting incorrect: Make sure you have made the right selection for roll or sheet in ImagePrint (via
the Roll/Sheet buttons in the MEDIA FEED section of the Dashboard) or centering issues may result.  Also, make
sure that the correct TRAY option is selected in the MEDIA FEED section of the Dashboard when printing on sheet
paper.  (Typical tray options are:  ASF (Automatic Sheet Feeder), Manual, Front, or Back).
• White border on images: Creating an image with a white border around it is a common cause of centering problems.  Remember, ImagePrint will treat the image in its entirety, and has no way of knowing that a white border is
not part of the image. It will therefore place the image beginning at the edge of the white border, which may cause
unexpected positioning results. It is usually recommended that images brought into ImagePrint not have any unnecessary white borders.
• Paper size: Make sure that the actual size of the page you are printing on matches the page size specified in
ImagePrint.  Surprisingly, papers sometimes are shipped from the manufacturer with slight size differences.  These
can result in non-centered printing.  Measure the paper to ensure it is the correct size if you see an unwanted border.  You can then use ImagePrint’s User Defined page size window to define a page size that exactly matches the
physical dimensions of your paper.
• Incorrect paper loading: How you load the paper in the printer can make a difference in the margins. Make sure
that you are loading it according to the manufacturer’s instructions.
• Printer margin set incorrectly: Many printers allow you to set the margin for roll paper on their front control panel.
ImagePrint assumes this margin is at the lowest setting (typically 3 mm). Make sure that your printer is currently
set to the lowest roll margin setting or incorrect margins will result.  (Typically, the Roll Margins setting is accessed
within the Printer Settings menu of the printer’s front panel. On Epson printers, the value with the asterisk is the one
in use--consult your printer manual for details on setting the roll margins for your specific printer).
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I’m getting an unwanted margin on my prints
In the following, orientation is always relative to the observer facing the front of the printer. For example,
Top refers to the leading edge of the paper as it comes out of the printer, Left refers to the left edge of the
paper as it comes out of the printer.
Borderless not set: If you want to print without any margin at all, make sure that borderless mode is enabled
in the MARGINS STYLE section of the Dashboard.  Remember--most printers only allow full borderless printing on roll paper, not sheet.  Also, only certain paper widths will print with no borders. Check the Printer
Specific section of the appendix of the ImagePrint User’s guide for information on the borderless capabilities
of your printer.  Remember, if you see a pink border surrounding the layout area within ImagePrint then full
borderless is not in effect. Full borderless mode will show no pink border.
1/8th inch margin on left or right side: A border on the left or right side when attempting to print in
borderless mode is usually an indication that the image is incorrectly positioned on the page. This can happen if you switched to borderless mode after you have positioned your image on the page. In that scenario,
the layout area will have changed but the image will still be positioned at the edge of the original (bordered)
area.  Always reposition (or remove and reopen) your images after making changes to the borderless setting.
1 to 2 mm “hairline”: Most inkjet printers can vary as much as 2 millimeters in the way they position the
edge of the paper.  This can cause a thin line to appear on the edge of your full bleed prints. The “Global
Printer Compensation” controls, available in the Preferences window of ImagePrint (found under the
ImagePrint menu) can correct for this hardware variability.  Setting a positive (right) or negative (left) X value
will move the entire layout at print time and allow you to correct for these “hairline” issues.
Printer margin set incorrectly: Many printers allow you to set the margin for roll paper on their front control
panel. ImagePrint assumes this margin is at the lowest setting (typically 3 mm). Make sure that your printer is
currently set to the lowest roll margin setting or incorrect margins will result.  (Typically, the Roll Margins setting is accessed within the Printer Settings menu of the printer. On Epson printers, the value with the asterisk
is the one in use--consult your printer manual for details on setting the roll margins for your specific printer).

Back
I’m getting a wasted strip of paper between each print
This usually means you are not set to the correct cut mode for your printer. Check in the Options window
(accessed by clicking OPTIONS in the ADVANCED->PRINT SETUP section of the Dashboard) that you are
set to “Single” as the cut method (for printers that support that option) to ensure your borderless prints are cut
without a strip of paper between prints. Look in the ImagePrint manual’s Printing chapter for more information
on Cut Modes. (Some older printers, such as the Epson 4000, 7600 and 9600, are not supported for singlecut mode and will always have some wasted paper when printing in borderless mode).

Back
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My print is too long or too short
Print-length issues are typically due to problems with the printer’s paper feeding controls. There are only two
controls that ImagePrint has for paper feed:
Media Type: The Media Type menu within the Dashboard -> ADVANCED -> PRINT SETUP ->
Options dialog (for printers that support it) allows you to choose a pre-set within the printer for different
media types. For thicker papers, select the closest match to your paper to ensure that paper is fed correctly.  (Ultra Smooth Fine Art Sheet is typically the thickest option available.)  
Media Feed Adjustment: If available, increasing the Media Feed Adjustment setting (also in the
Dashboard -> ADVANCED -> PRINT SETUP -> Options dialog) can have the effect of lengthening the
print by increasing the distance between printer passes. This slider rarely needs to be adjusted, but for
very long prints on heavy papers (like canvas) it can help to compensate for problems with the printer’s
paper feeding.

Back
The last few lines of my prints fade or don’t print
Wrong paper size (length): This condition can be caused by an incorrect page size setting.  If the page size
you have selected within ImagePrint is larger than the page loaded in the printer, the page may eject before
the last bit of the image is printed. Measure the physical page to make sure it came from the manufacturer at
the correct length--papers are often slightly smaller than the specified size (in which case you can specify a
smaller page size in ImagePrint’s User Defined page size dialog box).
Epson Driver interference: This can be caused by interference from the Windows Epson Stylus driver.  To
correct the problem, get properties on the Stylus driver (found in the Windows Printer Control Panel--make
sure to pick the printer with STYLUS in the name--NOT the ImagePrint installed driver) and, in its PORTS
tab, disable “Bidirectional Communication”. Note this will cause the Epson Status Monitor to not be able to
see the printer. You will need to turn this setting back on to use that utility, then off again to use ImagePrint.

Back
Jobs print distorted or as negatives
Color Management settings: Something very wrong in your ImagePrint Color Management window could
cause files to print distorted. Check the following:
In the ImagePrint Dashboard, in the PROFILES section (either the Profile Valet or the Choose by Profile
Name section):
- Make sure a correct printer/paper profile is selected for your paper and applied.  
In ImagePrint Preferences (found by choosing FILE in the Main Menu) choose PROFILES and
- Make sure Embedded Action is set to Apply
- Make sure that your normal Photoshop working spaces are selected in the Missing Profile 		
section for each color type.
Channels: Prints that appear reversed or negative may be due to extra channels in the image (open the
image in Photoshop and check, in the Channels window, that only the normal color channels appear)
Compression: Prints that appear reversed or negative may be due to extra channels in the image (open the
image in Photoshop and check, in the Channels window, that only the normal color channels appear)
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Pixel Order: For Tiff files, make sure the PIXEL ORDER setting is interleaved (NOT “per channel”).  This can be
checked in the Photoshop SAVE dialog.
Corrupt File: Rarely, a corrupted file can print with distorted results.  Make sure to try printing a different file, such as
one of the sample images within the TEST IMAGES folder within your ImagePrint folder.
Nozzles: You may also get this result if there is a severely clogged nozzle.  Do a nozzle check on the printer to
ensure the nozzles are all clean.
Incorrect Printer/Paper profile: Choosing a “Phatte black” profile  when you are not using the Phatte black ink set
can cause distorted prints, as can doing the opposite (printing with a non-phatte black profile when you ARE configured for Phatte black). .
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Prints show banding (lines)
Nozzles: The first thing to check if you are experiencing banding issues is the nozzles of the printer.  This is by far the
most common cause of this problem. Even one missing or incorrectly firing nozzle can cause unpredictable banding.  
Run a nozzle check, and, if nozzles are missing or incorrectly aligned, run printer cleanings until it is corrected. (Note
that ImagePrint, due to its enhanced ability to render detail, may show banding due to nozzle issue when the standard
manufacturer’s driver doesn’t).
Speed: Giving the print more time to absorb the ink as it prints by setting the Speed to a higher number of passes
may cure banding issues.  You can change the speed in the  ADVANCED -> Print Setup section of the Dashboard.
You can change the passes in the ImagePrint Print dialog. Going from 4 pass to 8 pass will effectively double the
print time.  Also, if you are set to a HS (high speed) quality mode, try a non-HS Quality to allow the print more time to
absorb the ink.
Media Type: The Media Type setting affects paper thickness controls on the printer--it is automatically selected when
you prick a paper profile, but if your printer shows banding you may want to try a differetn Media Type to compensate
for printer feed issues.  The Media Type setting is found by clicking OPTIONS in the ADVANCED->PRINT SETUP
section of the Dashboard.
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What do Passes (4-pass, 8-pass, etc.) mean in the Speed listing?
Many printers have the ability to move the print head over the same area of the paper, firing different nozzles each
time. The higher the number of passes, the more times the head will pass over the same area of paper, firing fewer
nozzles with each pass.  In the end, passes don’t make a difference in terms of what gets put on paper--the same
dots will be put in the same place--they will just take a longer (or shorter) time to get there. But more passes will give
the ink droplets more time to soak into the paper. This reduces the chances of droplets coalescing on the surface of
the paper, which is a cause of inking problems on the print such as banding, artifacts, or smudges.
Higher pass settings make a very significant speed difference, though--doubling the passes (say, from 4-pass to
8-pass) doubles the print time. So you should use a lower pass setting as long as you don’t see inking issues.
For most printers, the default pass setting that ImagePrint uses is 4-pass.

Back
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What does HS mean in the Speed Listing of the Print Setup area of the Dashboard?
HS in the quality name means “High Speed” or bi-directional printing. In this mode, the print head will put ink on
paper in both the directions that it moves across the page. (Non-HS mode printing only puts ink down as the print
head moves away from its original home position).  The ultimate position and size of the droplets on the page will be
the same in the end--HS just puts them there more quickly.
Bi-directional (HS) mode does significantly improve speed (by a factor of 2), but on some papers (typically glossy
ones) it may not provide enough time for the ink to settle into the paper before more ink is laid down, resulting in
potential banding, smudging or artifacts in the print.  Also the print head isn’t perfectly registered you may seen
alternating patterns of light and dark areas on the print. For slower computers or connections, you may find that the
printer is more likely to pause when printing in HS mode as it waits for more data from the printer.
As with most Quality settings, use of HS mode is a matter of using it if you see no negative results.  In most cases, it
is perfectly fine and will double your printing speed with no loss in quality.

Back
What Quality value should I use when printing? (2880? 1440? Photo? Best?)
The Quality values (which will be determined by the Printer/Paper profile you choose) refer to the droplet size used
by the printer. Typically, these are numeric values that refer to the number of droplets per inch, but for some printers
the qualities modes have names instead (such as BEST, PHOTO, FINE, etc.)
Smaller droplets sizes aren’t necessarily the best mode to use.  For example, 2880 is a very fine dot, but doesn’t
allow for variation in the droplet size on most printers, so,  it isn’t necessarily “better” than 1440 (which does allow for
size variation) since the ability to produce variable dot sizes can make a significant difference in the smoothness of
the dot pattern produced on the paper.
In most cases, ImagePrint’s profiles will be made for 1440 (on some printer’s, this is referred to as PHOTO quality). 2880 profiles may also be available, but due to the much slower print speed and dubious improvement in quality
at normal viewing distance, they are typically made only for some gloss papers (matte papers, with their large dot
spread, tend to lose any advantage the smaller droplet size might provide).
Lower quality modes, like 720, may be available as well.  Generally, 720 quality produces output that’s slightly   grainier and more susceptible to banding.
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What Resolution (PPI) should my images be saved at for best results?
Every print driver takes all the images on a page and builds a large raster (dot) image that is sent to the printer.
Regardless of the PPI (pixels per inch) of the images on the page, the information will be converted to the one of the
printer’s “native” resolutions at print time.  You can set this resolution via the DITHERING DPI setting available in the
ImagePrint Print dialog.
Note that this printer PPI is distinct from the quality that the printer is driven at. The quality setting for the printer specifies the size of the droplets (typically, specified in droplets per inch) that the printer will use to render the image on the
page. Since the printer uses multiple droplets to present each pixel of the image, the quality that the printer is capable
of doesn’t translate to the PPI of the image data that is sent to it. For example, a printer might print 1440 droplets per
inch, but within that inch, only 360 pixels of image data are represented.
ImagePrint can open images of any resolution, but it will interpolate them to the printer’s native resolution (the
Dithering DPI) at print time. (ImagePrint uses bi-cubic interpolation when scaling images).
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Since the RIP will interpolate the images to the native printer PPI, there’s no benefit for your images to be a  
higher PPI than that setting. In fact, anything above 240 PPI or so doesn’t show any improvement on ink jet
printers.  (This is 240 PPI at the printed size--if you’re scaling the image, of course, you’ll want to start with a
higher resolution.)
Therefore, as long as your image is 240 PPI or above at its printed size, your prints will be at their best quality. Giving us images at a higher PPI won’t hurt, but they won’t make a noticeable improvement on your output, either for photographic images. (The exception to this rule is when your images are vector (line work)
images. Single pixel lines, when interpolated, may result in unwanted moire type patterning--therefore, it is
often best to provide computer generated line work at the native resolution of the printer).
For most printers, 360 or 300 are the standard PPIs used--you’ll see one of those by default as the Dithering
DPI in the ImagePrint Print Dialog.  A lower setting (such as 180) may result in slightly faster processing
speeds, but can show a slight (although typically very small) increase in “graininess”.  It is therefore only
recommended that larger (5 feet+) images use the lower PPI settings instead of the default 360 (or 300).  At
larger sizes, the slightly more grainy output typically isn’t noticeable, as prints of that size are usually meant to
be viewed at a distance.

Back

Where should I scale my images--Photoshop, ImagePrint, or using a specialized program?
Because of the relatively low-resolution of an inkjet printer, it is doubtful you will see any difference between
images scaled via Photoshop, ImagePrint or a specialized program if you are doing no more than doubling
the size of the original image. (You may want to try some sample prints utilizing different methods to find what
is best for your workflow.)
One benefit of scaling images in ImagePrint is that you then won’t have to produce a “print ready” copy of the
image.  ImagePrint will scale the image “on the fly” with no need to save a 2nd copy at the desired print size.  
Also, when scaling the  images, ImagePrint uses bi-cubic interpolation at the final (dithering) stage of rendering it for print. Doing the scaling late in the process is a benefit, as it allows all other image processing to be
performed on the original (un-interpolated) data.
ImagePrint does -not- currently apply any sharpening to images during scaling, which may be a factor if you
are scaling your images more than twice their original size.  In those cases, you may wish to use Photoshop
or a specialized program like Genuine Fractals to scale your images.  (This is especially true if you are blowing the image up 4 or 5 times it’s original size. )
Again, it is often best to print some samples using different methods of scaling/sharpening to ensure you’re
not doing more work then you have to to achieve the same print quality.
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What is gloss differential?
Gloss differential is the effect of inked areas of a print having a different gloss (or shine) then non-inked portions. The problem is predominately seen on glossy papers, and is usually noticed as white areas of the page
appearing more shiny then the non-inked areas when the paper is viewed at a slight angle. Matte paper does
not show this effect to any noticeable degree.
Gloss differential has been reduced with newer ink sets on some printers (the inks maintain a gloss that more
closely matches that of the paper).
Laminating, or spray coating, the print will eliminate gloss differential.
Continued
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What is bronzing?
Bronzing is often described as a golden or bronze “sheen” seen on a print where the dark areas take on a
flattened appearance when the media is held at an angle. It only occurs on papers with a gloss coating (not
on matte) and is not visible when the print is viewed directly (straight on). It is strongest in the dark areas of
the print and is most noticeable with black and white output, where heavy use of black ink occurs.
Some Epson printers employ a lite-lite black ink that greatly reduces the bronzing effect. Because of this,
ImagePrint’s phatte black option (which makes no use of the lite-lite black) may show more bronzing on black
and white prints on glossy papers than non-phatte black prints.
Laminating or spray coating the print will eliminate the bronzing effect.
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What is metamerism and color inconstancy?
Color inconstancy is the phenomenon of an object (in this case, an ink jet print) showing different color casts
when moved from one light source to another. For instance, taking a print from daylight to fluorescent light
will cause the print to often appear more warm. Metamerism is a similar concept, and the two terms are often
used interchangeably, but metemerism is actually a reference to the amount of observable color difference
between two objects, and how that difference changes under different lighting. Both phenomenon are much
more apparent in colored inks than gray/black inks, so the effects are more prominent on color prints then
black and white.  ImagePrint’s black and white printing (using a “gray” printer profile), makes use of very little
color ink and shows virtually no metamerism or color inconstancy.
For color printing, ImagePrint provides printer profiles optimized for different lighting conditions.  This can help
to optimize your output for the viewing environment it will be displayed in--you can see which light a profile is
made for by looking at the abbreviation at the end of the profile name, such as “DAY” for daylight, or “CWF”
for “Cool White Fluorescent”.  More information on profiles names  can be found later in this guide in the entry
entitled: What do the profile names mean?
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Profiles & Color Management/The Profile
Manager utility
Problems and questions related to ICC/ICM color management and profiles, and issues with the Profile
Manager utility are discussed here

My printed colors/tones don’t match my display
Printed output not matching the display on the monitor is one of the most common frustrations in any workflow. Following are the most common causes of this problem and their solutions.
Remember---ImagePrint is always soft proofing, meaning it is passing its display through the printer profile.
Your display in ImagePrint should look close to your print if you are using a calibrated monitor and your settings are correct. As a test, always look at the display in ImagePrint and compare it to the print--don’t just
compare it to the display in Photoshop. For soft proofing issues within Photoshop, make sure to also consult
the entry in this guide entitled: Photoshop doesn’t match my output (softproofing)).
• NOZZLES: First and foremost, make sure you have performed a nozzle check on the printer and that no
nozzles are clogged.  Clogged nozzles are the number-one cause of color issues.
• Incorrect ImagePrint Color Settings: Double-check your color management settings in the ImagePrint
Color Management window (available under the Image Menu).  Chapter 6 of the ImagePrint users manual
discusses Color Management settings in detail, but here’s a check list:
In the ImagePrint Dashboard, in the PROFILES section (either the Profile Valet or the Choose by Profile
Name section):
- Make sure a correct printer/paper profile is selected for your paper and applied.  
In ImagePrint Preferences (found by choosing FILE in the Main Menu) choose PROFILES and
- Make sure Embedded Action is set to Apply
- Make sure that your normal Photoshop working spaces are selected in the Missing Profile
section for each color type.
- The PRESS MATCH / SIMULATION profile should be NONE unless you are intentionally trying to match your output to a PRESS. In almost all cases, when printing photography, leave this setting at NONE.
- The Colorized B/W field is only used if you are printing an image with mostly neutral data,
and some color portions you wish to use a color profile for. Otherwise, leave this setting at
NONE.
• Uncalibrated Monitor: Make sure you have calibrated your monitor before attempting to match your
screen to your prints.
• Two Monitors: If you are using a two monitor system, it is important to understand that ImagePrint will only
recognize the monitor profile for your System monitor.  Therefore, if ImagePrint’s display is residing on a
secondary display, the monitor profile may be incorrect. It may be necessary to designate the secondary
monitor profile as the System monitor profile to have ImagePrint show colors properly on the second monitor.
• Too Dark: If hues are fine, but overall darkness is the issue, it’s likely you are using an LCD monitor and
the screen is too bright even if your monitor has been calibrated.  When LCDs became the norm, this  
became a common problem as LCD’s are factory set in almost all cases to be brighter than CRTs, and caliT47
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brating doesn’t bring the gamma down enough. (This is chiefly due to LCDs having trouble rendering deep
shadow detail--increasing the brightness opens up the shadow display at the expense of a too bright display). The solution is to manually tone down the brightness with the monitor’s brightness controls to match
the print.
• Incorrect Soft Proofing: ImagePrint’s display always soft proofs, so it should always match your print reasonably well on a calibrated monitor. Photoshop’s display only soft proofs when you have set Photoshop to
do so--otherwise, it will display the image with absolutely no allowance made for the paper and inks you are
using, displaying the image the same for a watercolor paper as it would for a high-gloss film. Check the section later in this guide entitled: Photoshop doesn’t match my output (softproofing) for details on soft proofing
with Photoshop.
• Improper Color Management: If your images are not color managed correctly, your output will not be correct. To avoid this, a basic understanding of color management principles is important, but often problems
can be avoided by simply making sure you are aware of the color space the images are in at every step in
your workflow, and that your images are never incorrectly assigned the wrong source profile.
For example, if opening an image without an embedded profile in Photoshop, you will typically be prompted
on how you wish to color manage the image.  If you choose “Use my current working space” and your current working space is not the one the image was created in, Photoshop will incorrectly assign the color
space to the image, resulting in distorted colors. Sometimes, printing with the standard manufacturers driver
will not show the problem, as those drivers often “dumb-down” the image to an sRGB color space at print
time, but can show up when printing in a properly color managed RIP like ImagePrint.  More information on
Color Management is available in chapter 6 of the ImagePrint manual.
• Wrong Lighting: The ink used in inkjet printers always exhibit some level of color inconstancy (the tendency
to look different under different types of light). Make sure to use the right profile for the lighting you are viewing your color prints in (for example, a print made using a profile with “day” in the title is optimized for daylight viewing).  For more information, consult chapter 6 of the ImagePrint user’s guide.  For information on
the profile names, check the entry entitled What do the profile names mean later in this guide. (Grayscale
printing with a ColorByte GRAY profile is much less susceptible to inconstancy due to the greatly reduced
used of color inks).
• Wrong side of the paper: Sometimes it’s hard to tell which side of the paper to print on. Make sure you are
printing on the coated side (as a test, touch a wet finger to each side of the paper--the stickier side is usually
the coated (printable) one).
• Phatte or non-phatte: For some printers, ImagePrint supplies “phatte” profiles, made for printing in our
special phatte-black mode.  These profiles will always have “dk” in the title instead of the usual “pk” (photo
black) or “mk” (matte black).  If you are not using a phatte black ink cartridge in your printer, do not use a
profile with “dk” in the title.  Alternatively, if you ARE set up for phatte black, ONLY use profiles with “dk” in
the title.
• Older gray profile: If using ImagePrint versions 8, 7 of 6, “gray” printer profiles will have “6” in the title.  
Older gray printer profiles (without the “6”) were made for earlier versions of the software and will give incorrect results with version ImagePrint 8 or 7 (or 6.x).
• Somebody else’s printer profile: Printer profiles don’t just characterize paper and ink.  They are a fingerprint of how a RIP or driver lays down ink.  Therefore, never use a profile made for another RIP or the
manufacturer’s driver with ImagePrint (or vice-a-versa) or incorrect colors will result. If you create your own
profiles for use with ImagePrint, make sure to create them by printing an un-color managed profiling target
from ImagePrint according to the instructions in the ImagePrint Manual’s Appendix.

Back
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If using the new Profile Valet, you won’t usually need to be concerned with the profile name, but if using
an older printer or if you don’t have an internet connection at your ImagePrint computer, you may need to
use the Choose by Profile method of selecting your profile--the following information should be helpul in
making sure you pick the right one.
ImagePrint’s profiles start with the PRINTER NAME (abbreviated), followed by the INK SET used for this
profile (mk is matte black, pk is photo black, dk for “Phatte Black” (dual black) mode)).  Next may come the
VERSION LETTER of the driver (currently “b”) they are made for, then the PAPER TYPE (sometimes very
abbreviated) and the QUALITY at which they were made (if no quality appears in the name, assume 1440
for most printers.  The Quality setting refers to the droplet size the printer will use, as well as the number of
passes and HS (high speed) mode.). You may also see a number (i.e. “6”) indicating which version of our
profiling target (not which version of Imageprint) was used to generate the profile. The designations at the
end of the name refer to the lighting temperature the print will be best suited for.
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What are the LIGHTING designations within the profile filenames?
The designations at the end of the printer/paper profile file name refer to the lighting temperature the print
will be best suited to be displayed in.
Inkjet printers often exhibit color inconstancy (which is the characteristic of a print changing its appearance
as it is moved to different lighting conditions) so ColorByte gives you a few choices to enable you to pick
the conditions that most closely will match where the print will be viewed.  (Although you can’t always know
where a print will be viewed, having the ability to choose the temperature can make a big difference. If you
know your print is going to viewed in a museum that uses Tungston lighting, you can pick the profile that
will show it best there. If you are planning on hanging your print near a window, the Daylight profile would
show it best.).
Not all lighting temperatures will necessarily be available for each profile made.  And, for most profiles, only
the EDAY, F2 and F3 profiles are included on the cd.  (The ETUNG and ECWF profiles can be downloaded
from the ColorByte profile repository at www.colorbytesoftware.com.)
The current temperature abbreviations are:

ETUNG Tungsten

Continued
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EDAY

Daylight (Most printer drivers only supply daylight optimized profiles, so this type may
be best for an “apples to apples” comparison of ImagePrint prints to prints done via
other methods).

ECWF

Cool White Fluorescent

F2

Fluorescent, alternate version (this version is a bit less warm than our standard
ECWF profile, some people, especially portrait photographers, prefer it). This temperature was previously abbreviated with “ECWF2”.

F3

Mixed lighting (daylight with fluorescent). This the best profile to use for general lighting conditions, such as that found in offices. (NOT AVAILABLE FOR ALL PRINTERS
and PAPERS)
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ImagePrint doesn’t match my Photoshop display! (SoftProofing)
This entry addresses the use of soft proofing within Photoshop to ensure the Photoshop display is compensating for the printer, ink and media being used when printing. For problems with the appearance of the
prints themselves, consult the portion of this guide entitled My prints don’t match my display.
If Colored Images don’t show the same colors as Photoshop’s display...
By default, Photoshop does nothing to compensate for how an image can print on a given
output device. It has no idea of the printer’s gamut, or the media (matte or gloss), or what
ink you are using, or even the capabilities of the RIP--even though all of those factors have
a tremendous affect on what colors and densities you will be able to print. Photoshop just
displays the image as best as it can within the gamut of the monitor. It’s therefore no wonder that Photoshop won’t automatically match the output of your printer, especially if you are
using a RIP (like ImagePrint) that maximizes the output capabilities of the device rather than
restrict it to a monitor-like color space.
You can, however, tell Photoshop to use ImagePrint’s color profiles when creating its display,
allowing you to work in a Photoshop environment that reflects more closely how ImagePrint
will print your files.  This is called Soft Proofing, and is done via the PROOF SETUP feature
of Photoshop.
To cause Photoshop to pass its display through ImagePrint’s printer profile, you must first
copy the printer profile you are using in ImagePrint into the color profile folder used by
Photoshop.
The ImagePrint Profile Manager can do this for you.  Just choose the profile on the left side
of the profile manager window, then choose “Install profile for Photoshop soft proofing” from
the File menu. For information on the Profile Manager, check out the Color Management
section of the ImagePrint Users manual.
If not using the Profile Manager, you can copy the profiles in to place manually by right-clicking them, and choosing “Install” in the menu that appears (or manually copy the profile to: /

winnt/system32/spool/drivers/color)

Once in place, this profile can be selected within Photoshop via Photoshop’s Proof Setup
option.  By choosing View->Proof Setup in Photoshop, then clicking the CUSTOM button,
you can choose the Imageprint profile, causing Photoshop to bring it’s display within the
gamut of the printer/paper/ink and RIP.  
Note: There are other options within the Proof Setup window that may or may not have an
effect on matching your output (such as simulate paper white). The best way to determine
which features to turn on is to print a sample image from ImagePrint, then compare it to the
screen display of Photoshop with Proof Setup in effect. Try the different options, and use
the ones that cause the display to most closely match the print.
Note: If you find that ImagePrint shows more shadow detail than you are used to in Photoshop, you can
increase the darkness of the prints, at the possible expense of losing some shadow detail via the Shadow
Point Compensation slider, located in the Output section of the Color Management window. Note that setting the INTENT for the colorspace of your image to RELATIVE COLORIMETRIC (within the Bitmap section
of the Color Management window) will make the Shadow Point Slider’s effects much more dramatic.
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If Grayscale images don’t look the same in Photoshop as in ImagePrint...
For grayscale printing, Photoshop’s Proof Setup cannot be used with ImagePrint’s current
grayscale profiles, as Photoshop does not recognize the format of those profiles (this may change
in the future). In that case, Photoshop Adjustment Layers can be used to simulate ImagePrint’s
output in Photoshop. Here’s the procedure to follow:
•

Print an image through ImagePrint, then open that image within Photoshop.  

•

Choose Image->Curves from the Photoshop menu.

•

Adjust the curve to match your ImagePrint output.  

•

Once you have a curve that causes the on screen image to match the print, click the Save
button within the Curves dialog box, and save the Photoshop curve as an adjustment layer
(you may wish to give it the name of the media you are matching).

•

You can create multiple adjustment layers in this way, each characterizing a different
media output of ImagePrint.

•

To enable/disable a particular adjustment layer, simply click the layer visibility icon (an eye
symbol) within the Layers palette of Photoshop. This will allow you to work in a Photoshop
environment that simulates how ImagePrint will print for that particular media.

Important:  When saving the image, you should make sure that none of these custom
adjustment layers are enabled in the layers window (the “eye” icon should not be beside
any of them). This will ensure that the information in that layer is not saved with the image,
which would be undesirable as the adjustment layer is used to adjust the Photoshop preview
only, and should not be applied to the image data itself.
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Where can I put profiles to have Photoshop see them (for use in Soft Proofing?)
Color profiles must be copied from the Color folder, which is located in the ImagePrint folder into the folder
that Photoshop uses for 3rd party color profiles.
The ImagePrint Profile Manager can do this for you.  Just choose the profile on the left side of the profile
manager window, then choose “Install profile for Photoshop soft proofing” from the File menu.  For information on the Profile Manager, check out the Color Management section of the ImagePrint Users manual, or
consult the entries related to the Profile Manager elsewhere in this guide. If not using the Profile Manager,
you can copy the profiles manually. The location they should be placed in is:
On Macintosh OSX the folder is:

/library/application support/adobe/color/profiles
On Windows the folder is:

/winnt/system32/spool/drivers/color
Back
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How do I achieve consistent Color Management
ImagePrint is a tightly color managed application. If you observe proper color management techniques in your
workflow, your results will be outstanding, but, by the same token, incorrect color management can lead to unsatisfactory output. In fact, you are more likely to see the negative results of incorrect color management in ImagePrint
than in less advanced RIPs—just as correct color management will give you superior results to  those other RIPs.
Following is a brief discussion of some color management issues that often come up when wrestling with a
achieving proper output. For more details on ImagePrint’s use of profiles and color management, see chapter
6 of the ImagePrint users guide.  There are also many books on the subject--Bruce Fraser’s “Real World Color
Management” is one that many have found invaluable.
ICC (or ICM) color profiles define color spaces. Color spaces define the full range of color for an image or device.
In a color managed workflow, all an image’s potential colors (gamut) are defined by a color space determined when
the image was created or edited. This is the source space of the image.
Your printing conditions will also be defined by a color space--one that specifies the range of colors that can be produced by the printer on a given paper and ink. This is the output space.
At its core, ImagePrint’s color management engine job is simply to convert the colors in your image from their
source space to the output space of the printer/paper/ink.  Doing this in a way that preserves the original look of the
image is the goal. (Of course, results will be dependent on the original color space of the image, and the limitations
of the printer, ink and paper in reproducing those colors.)
There are many opinions as to which is the “best” source color space for images to give the best results when printing. Common source spaces include sRGB, Adobe 1998, Color Match RGB and Pro Photo RGB.  Detailed discussion of which space is the correct one for your workflow is beyond the scope of a troubleshooting guide, but some
basic things to consider are:
•

Smaller spaces, like sRGB, have the advantage of having fewer colors that fall outside the output space
of the printer, so you are less likely to get surprised by colors that appear one way on the monitor printing
differently--however, you are limiting the available gamut of colors within the images.

•

Large spaces, like Adobe 1998 and Pro Photo RGB, are bigger than the printer’s gamut in more areas, so
its likely some colors will need to be altered more severely to bring them into printer gamut at print time. (In
fact, because these color spaces are usually also bigger than your monitor’s gamut, you likely aren’t even
seeing some colors as they really are when viewing them on screen.)
Of course, you have the advantage of a wider range of colors in the original image when using a larger
space, which is helpful when doing color processing and image editing, as well as potentially useful if you
plan to use the image in other ways beside printing, or archive them for future use.
In any case, because colors are likely to fall out of range of the printer more readily--when printing files
from a wide gamut source space, make sure to soft proof the image within Photoshop and make use of
Photoshop’s GAMUT WARNING feature to compensate for colors that fall outside of the printable gamut.
(More information on soft proofing in Photoshop is available elsewhere in this guide, in the Photoshop
doesn’t match my prints entry.
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Perhaps more important than which color space your images use is that consistent color management is observed
throughout your workflow.  Many color-managed workflows are broken when an image is incorrectly “dumped” into
the wrong color space, resulting in undesirable color and gamut shifts.
This often occurs when an image is opened for the first time in Photoshop.
When you open an image, Photoshop uses what it calls “policies” to determine the best way to handle the color
space of the image if it doesn’t match the source color spaces Photoshop is currently using. (You can see
Photoshop’s current color space settings in its Color Settings window). In most cases, Photoshop’s policies result in
a dialog box appearing when you open an images that doesn’t match Photoshop’s current settings. This dialog will
ask if you wish to 1.) Use the embedded profile in the image (if it exists), 2.) Use Photoshop’s current working space,
3.) Specify another working space, or 4.) Disable color management altogether (bad idea).
Some images already have a color profile embedded in them.  (An “embedded” profile just means the profile that
was used when the image was created or last edited is included within the data of the image file so programs like
Photoshop and ImagePrint know right away what its source space is.) In those cases, its easy for Photoshop to
open the image into the correct color space or even to convert it into another space, since it knows the color space
the image came from it can handle things correctly.
It’s when there is no profile embedded in the image that things can go wrong. In those cases, Photoshop can’t tell
what source color space the image is in, so it is “flying blind”.  This is where you need to know the appropriate color
space to tell Photoshop to use when it opens the image.
For example, assume your current working (source) space in Photoshop is Adobe 1998.  If you open an image without an embedded profile, Photoshop will display its usual prompt asking what you want to do with this mysterious
image. If you choose “assign working RGB: Adobe 1998” and the image wasn’t originally created in that color space,
you’ve just messed up its colors.
The same thing applies if you choose the “Specify another profile” option, but pick a profile that the image wasn’t created in--Photoshop essentially dumps the image into that space, and colors get... messed up. This is probably the
single most common pitfall of color managed workflows--opening an untagged image into Photoshop’s current RGB
working space when the image wasn’t created in that space.
So...if the image doesn’t have an embedded profile, how do you know the appropriate color space?
Generally, Digital cameras tend to use SRGB type color spaces, so that’s the one to use if in doubt for those types
of images.  Scanner images often are best opened into Colormatch RGB or Adobe 1998.  If neither of those give
you good results, you may have to find out from the manufacturer, or the person that provided the image, what color
space it was created for.
Once you have the image in the correct working space within Photoshop, you can then, if desired, convert to another
working space doing a profile to profile conversion (typically done under the Image -> Mode menu in Photoshop).
Since Photoshop knows where the image is coming from (source space-wise) and where it is going to, it can do a
proper conversion, and your image should not suffer (assuming you are converting it to an appropriate color space
for the image’s ultimate destination).
Finally, to ensure consistent color management, it is a good idea to embed the profile when saving your image from
Photoshop via the Embed profile checkbox in Photoshop’s Save File dialog. This will enable other applications, (like
ImagePrint) to know the correct color space automatically for the image, and greatly reduces the risk of profile mismatching.
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I want to make my own profiles
The appendix of the ImagePrint users manual gives full instructions on outputting your own uncolor managed color
profile targets for profile generation via “off the shelf” color profiling software and equipment.
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How do I get new paper profiles?
With ImagePrint 10 and the Profile Valet, profiles are downloaded automatically as needed for most printers if you
have an internet connection on your ImagePrint computer. If not using a printer supported by the Profile Valet, or if
no internet connection is available, you’ll need to download profiles manually via the below instructions.
ColorByte maintains a large profile library on it’s web site. You can access the web site via the link on our support
page, but the best way is via the Profile Manager. The Profile Manager is an easy to use utility that can be used
to find and download profiles. It will download them directly to the ImagePrint color folder, so you don’t’ have to
manually put them in place. It also can perform many extra functions, such as displaying the name of the paper
the profile each profile is made for, putting the profiles in the right spot for Photoshop to use for soft proofing, and
removing any unwanted profiles from your ImagePrint color folder. For more information on the Profile Manager,
consult chapter 6 of the ImagePrint User’s Manual, consult the Profile Manager’s HELP menus,  or check out the
following entries related to its use.
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Where do I get the latest version of the Profile Manager?
The Profile Manager is included in all current installers and updaters and will be installed into your ImagePrint folder:
Default location: c:\program files(x86)\imageprint\profile manager.exe
With ImagePrint 9 and 10, and the Profile Valet, the Profile Manager is not needed to download profiles for MOST
printers--profiles can simply be downloaded from within Imageprint itself. However, older printers still rely on the
profile manager, and it has some other useful functions as well.
The latest version is always available from our Web Site.  By going to www.colorbytesoftware.com you will find a
link in the DOWNLOADS section of the page for the Profile Manager for both the Windows and Mac version.  Click
the link to have the Profile Manager downloaded to your computer (for Mac users, the file will be a disk image
(dmg) file--double-click it to mount the disk image, then drag the Profile Manager application to the folder of your
choice).
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Downloading/accessing profiles is slow
ColorByte’s web site, installers, updaters, and profiles are constantly being downloaded, and at certain times the
volume of traffic can cause access speeds to suffer. Try downloading at another time.

Back
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The Profile Manager doesn’t launch at all!
Problems with the Profile Manager launching are rare--usually they are due to a file in your ImagePrint
COLOR folder that is not supposed to be there--a sub-folder, or a non-profile.  Only ICC/ICM profiles should
be in your ImagePrint COLOR folder, and any other files can cause the Profile Manager to “hang” at launch.  
To correct the problem, open the Color folder from its location in your ImagePrint folder and remove any nonprofiles.
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I downloaded a profile but don’t see it in ImagePrint’s printer/paper profile list
Restart ImagePrint: Make sure you have restarted ImagePrint since downloading the profiles--ImagePrint
does not automatically detect newly added profiles until it is restarted.
Pick the right printer: ImagePrint only shows profiles that are valid for the currently selected printer--make
sure, in ImagePrint, the printer you have selected at the top of the ImagePrint Dashboard is the right one for
the profiles that you downloaded. Be careful that you download the right profiles, too--it is easy to accidently
download profiles for an “X880” printer instead of an “X800” printer, for example.
Look for the description, not the profile file name: When downloading profiles, the Profile Manager
displays the profile’s file name in its list. However, within ImagePrint’s Choose by Profile section of the
Dashboard’s Profile area you will be seeing the internal description of the profile, which may differ significantly
from the file name (the file name tends to be more abbreviated due to constraints in the number of allowed
characters).  Remember, the Profile Manager also shows the profile description of the currently selected profile at the bottom of the profile listing.
Windows “Virtual Store”: Windows may be redirecting the profile downloads to your Windows “Virtual Store”
folder--this happens as a security measure on some Vista and Windows 7 systems when utilities such as the
Profile Manager are not granted permissions to download files to ImagePrint’s Color folder. The quick workaround is to always launch Profile Manager by right clicking its icon and choosing “Run as Administrator”.  
Another workaround would be to disable your UAC (User Account Controls) via your “User Accounts” control
panel, though this may make your Windows system less secure.
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The Profile Manager launches, but is not working correctly
Can’t log in: If you can’t log on to the ColorByte Profile site, it may be due to a firewall or other network setting on your system. Disable any internet access related software and see if that corrects the problem.
No profiles shown: If the Profile Manager is not showing profiles on the right (remote) side of it’s interface,
make sure the “View All” profiles checkbutton is selected in the top portion of the Profile Manager window.  
Also, try deselecting the “Show Installed Printers Only” button.
Reset the Profile Manager preferences: Some problems can be corrected by resetting the Profile Manager
preferences file.  Profile Manager 1.8 and later have an option “Delete Settings and Restart Profile Manager”
in its SETTINGS window (accessed from the File Menu) for this purpose.
No ImagePrint installed: If you don’t have ImagePrint installed on the system you are using the Profile
Manager on, it may function a little differently--specifically, since there will be no ImagePrint COLOR folder on
your system in this case, the Profile Manager will prompt you for a default folder to download profiles to upon
launch.  Any profiles downloaded from our site will be placed in to this folder.  You can then copy those profiles manually to the computer with ImagePrint installed (profiles should be placed in the COLOR folder within
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your ImagePrint folder).
Reinstall: If all else fails, try re-downloading the Profile Manager via the instructions earlier in this guide:
Where do I get the latest version of the Profile Manager? Overwrite the old profile manager with the newly
downloaded one and see if the problems go away.
Use an FTP Client: You can download profiles via a standalone FTP client by using the hostname:
ftp.colorbytesoftware.com.  At the time of this writing the username is “profiles” and the password is also “profiles”. Without using the Profile Manager, the profiles will only be browsable by their file names, which can
make finding the correct profile more dificult.
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I can’t find the paper profile I need
First, make sure to use the Profile Valet (if applicable) or the Profile Manager utility to check our site for the
profile.  Instructions on use of the Profile Valet and the Profile Manager are contained in chapter 6 of the
User’s Guide, or within the Profile Manager’s HELP menus.
If you don’t see a profile for the paper you are using on the ColorByte Profile site, we may not have it. Send
an email to the ColorByte Support dept at support@colorbytesoftware.com with the exact paper name, the
printer you plan to use the profile with, the black ink you are using if applicable (i.e. photo or matte black)
and your 6-digit dongle number.  We will check to see if we have the profile available (maybe we just haven’t
uploaded it yet)--if not, we may ask you to send us some of it so we can generate a profile.
ColorByte may generate profiles for free if:
We don’t already have a profile available
The media you wish to have profiled is a valid one for your printer
You can supply us with some of the paper (typically the equivalent of 3 11x14 sheets or larger per profile--6 if you need both gray and color profiles) in perfect condition to use for the generation of the profile.
IMPORTANT: Even if the above applies, we do not create profiles for uncoated papers, transparencies, or
most “unusual” media such as metals.  Profile generation times vary greatly depending on ColorByte’s volume, but typical turn around time is about two weeks.
In some cases, rather than get samples of the media, we will ask you to output our profiling target and send it
to us--ColorByte will let you know exactly how to do that if it is necessary.
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Solutions to problems with AutoPrint, the hot folder utility, are listed in this section

AutoPrint lays out images, but they never go to the spooler
Check the TRIGGER settings, in the GENERAL SETTINGS section.  AutoPrint will only send the current layout to the spooler when the specified trigger(s) are met.

Back
AutoPrint jobs print with the wrong colors
Make sure that you have chosen your Color Profile settings correctly within the COLOR SETTINGS window.  
These settings follow the same rules as the Color Management window within ImagePrint itself, so make sure
to consult chapter 6 of the ImagePrint users guide for details on proper color management settings.
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AutoPrint jobs show an error in spoolface
Consult the entry earlier in this guide entitled SpoolFace error codes to track down the cause of the error.
Just like with ImagePrint, problems with color management, or problems with the files being printed (such as
compression being used when saving them) can cause errors at print time.
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AutoPrint doesn’t show all my profiles in its Color Settings window
Unlike ImagePrint, AutoPrint will only show profiles that have an “.icm” or “.icc” extension in their file name.  
Rename the profiles to have that extension to have them show up in AutoPrint.

Back
AutoPrint won’t launch
• Make sure that both the AutoPrint file, and the TOOLS folder, are in the ImagePrint folder.  They can not be
in a sub-folder within the Imageprint folder, but instead have to be directly in the ImagePrint folder.
• Corrupt profiles in the Color folder may make AutoPrint fail to launch. Remove any recently added profiles
and see if that corrects the problem.
• Make sure your launching AutoPrint from your ImagePrint HOST computer.  AutoPrint only can be run from
the ImagePrint HOST (the computer with the dongle) NOT a Client.  (To use AutoPrint across a network,
simply run it on the HOST computer, and mount the Hot Folder(s) on the remote machines. Users on the
remote machines can simply drag images into the mounted hot folders to have AutoPrint access them on
the Host.
• If AutoPrint’s preference files have gotten corrupted you may have trouble launching.  You can delete these
files from their location in the “/Program Files/ImagePrint/TOOLS/AutoPrint” folder.   The settings file is
called “autoprint.txt”.  Deleting it may solve the problem, but you will need to manually re-set your AutoPrint
settings.
• If you have been doing a LOT of printing with annotations, you may have accumalated too many temp files
in the TEMP folder, within the ImagePrint folder. If there are thousands of files in this folder, delete them
and that may fix the problem.
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AutoPrint layouts show a border along the edge
This is usually when you are set to BORDERLESS printing mode.  When in borderless mode, the printer will
“overprint”, causing 1/8 inch or so of each image to fall off the page, which can result in an unexpected border or cropping.  Using the “Optimize Margins for Borderless” feature, in the Margins section of the Layout
Settings window, should correct the problem by offsetting your layout to ride along the edge of the page.

Back
I Can’t find AutoPrint
AutoPrint is included in all Window’s installation cd’s, but is not included in ImagePrint installer downloads
(to keep the size of the download small).  You can always download the latest version of AutoPrint from
ColorByte’s web site though.  By going to the SUPPORT page at www.colorbytesoftware.com, and choosing
the FTP link, you will access our general FTP site. The archive: AutoPrint for Windows will be listed within
the AutoPrint Files folder there.  Download it, then unzip the archive.  You will then have a folder containing
the AutoPrint executable.  Place that file in your ImagePrint folder, and you are ready to double-click AutoPrint
to launch it.  Note that the first launch of AutoPrint may take a minute or more to load, as it is creating some
necessary files. Subsequent launches will be much quicker.
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I found an AutoPrint feature that’s not in the Manual!
As a dynamic, scripted application, AutoPrint is updated frequently, and the ImagePrint documentation often
can’t keep up with new features that are added.  Virtually all features in Autoprint do have “balloon help” associated with them. By hovering your mouse over the feature for a few seconds, a window containing a brief
description will appear (make sure that balloon help is turned on in the View menu of AutoPrint).  If that isn’t
enough, please email colorbyte for a description of the feature.
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How do I access different printers and/or hot folders with one copy of AutoPrint?
AutoPrint’s QUEUE feature allows you to have a virtually unlimited number of hot folders, each with it’s own
group of settings.  Remember, each printer and/or queue should have a unique hot folder chosen for it.
By launching AutoPrint multiple times, and picking different printers and queues, you can monitor different
hot folders at the same time.  To automate the process, use the “Create Auto-Launch Shortcut” feature in
AutoPrint’s FILE menu.  That will create a shortcut on your desktop that will launch AutoPrint and automatically switch to the printer and queue that the shortcut was made for.

Back

T58

IMAGEPRINT                                Troubleshooting

Back to Table of
Contents

